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1 Interface Overview

Luxriot EVO Monitor is a dedicated application for viewing live and browsing the recorded contents of connected
Luxriot EVO servers. It also includes advanced features such as video and snapshot export, alert monitoring, PTZ
and digital PTZ control, among others. As Luxriot EVO Monitor is a unified interface for all Luxriot EVO editions,
some of the features described in this document may only be present if you are connected to Luxriot EVO Global
server and are not available for other server types (for example, the video wall feature).

We recommend that end users and CCTV station operators become acquainted with this document in order to
understand the application interface and work out some personal usage strategies.

Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.2.0 or 1.4.0.

Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible, but we still
recommend that you match the software versions strictly for best performance.

For best user experience, the display resolution of 1280x720 pixels or higher is recommended for Luxriot
EVO Monitor application, alongside 512MB onboard video memory per display.

General

The Luxriot EVO Monitor interface is mostly intuitive. Elements are manipulated using left mouse button (click,
drag and drop) and mouse wheel (e.g., to change digits in timestamps). Right clicks (pop-up menus of all sorts)
have been eliminated to facilitate the Luxriot EVO Monitor application for usage with touch displays.

The application appearance can be changed to accommodate individual users' needs and preferences. Overlay
elements are adjusted in the Application settings, and component colours - using the Themes tool. These settings,
alongside with local resources (layouts and sequences) and the list of servers can be saved into a file for further
import on other workstations.

The main application functionalities are available via tabs. Visibility of these tabs and certain interface elements can
be controlled for each Luxriot EVO Monitor application instance using the Luxriot EVO Monitor Administration
Tool, which is available via main menu View -> Administration Tool.

Luxriot EVO Monitor interface
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The Luxriot EVO Monitor application window title displays window name, display number, computer station name,
and also video wall title and display number.

Most elements (buttons, menu items, overlay elements) have tooltips - text hints that appear when you position the
mouse cursor over the item and hold it for a moment. Tooltips are enabled by default and can be turned OFF
via application settings.

Also, many user interface controls have hotkeys - keyboard shortcuts. Some useful key commands: use ESC
(Escape) to deselect a viewport in live or playback (remove yellow frame); CTRL+Shirt+U will unmap all current
viewports (comes handy on remote connections), and CTRL+Shift+A will map all empty viewports with channels,
filling the layout automatically. Go to the main application menu Edit > Command Mapping to change the hotkey
combinations from the defaults, and define keyboard commands for less popular commands (unassigned by
default).

Application Windows

The main (primary) application window displays contents provided by server or servers in different
modes, depending on the tab selected. All secondary windows only display live channels, without any supplementary
tabs, menus or panels. Please refer to the Interface Elements section of this document for detailed information about
all Luxriot EVO Monitor panels, buttons and other controls.

The Luxriot EVO Monitor application is always running in the single instance mode, meaning that it should only be
launched once. Additional (secondary) windows can be opened on all additional displays.

Upper Panel: Tabs

The upper panel contains tabs that allow you to quickly switch between the main software functionalities. Some
tabs (e.g., Live, Playback) are always present while other ones (Access Control, LPR etc.) only appear when the
related feature or contents is available on one of the connected servers. Tabs are only present for the main
application window.

Upper Right: Connections and Main Menu

The Connection button opens a dialog box with the server list. Next to it, there is the main application menu, which
contains items for the Luxriot EVO Monitor tune-up and additional wizards.

Below the main menu, there is a button for multi-display setup and another one for managing the current
display contents.

Left: Resources

This section displays resources from the connected servers: layouts (including layout templates and sequences),
channels, maps, and user buttons. The resources panel can be hidden by clicking the << arrows in its upper right
corner to free up more display space for the contents.
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2 Interface Elements

This topic covers Luxriot EVO Monitor interface elements in more details.

Application elements and sections can be configured to be hidden via Luxriot EVO Monitor administration
tool. By default, all functionality is available based on the Luxriot EVO server configuration and license
limitations.

Main Viewing Area

The main (central) viewing section displays contents provided by the connected servers. The type of the contents
depends upon the selected tab: this may be live video, several types of playback, data from external services
etc. Please see the corresponding sections of this document for detailed information about each mode.

Above all viewports, you will see < arrows >: these allow you to undo/redo the changed you make to the layout in
the live view and playback modes. For example, if you accidentally removed a channel from the view, simply click
the < arrow to the left to go one step back (undo the last action).

up to 50 actions are remembered in the current application launch
available for live view, instant playback, and multichannel playback on the main display
both manual actions and channel popup
live and playback share history unless the Allow different layouts for live and playback option is enabled
in the application settings (under main menu Edit > Settings > Usability)

The state history is not available while a layout sequence is being played.

Top Right: Window Controls

Standard window controls: go fullscreen, minimize, restore and close

From this panel, the Luxriot EVO Monitor application window can be:

opened in fullscreen mode
minimised to taskbar
maximised/restored to default size
closed

To toggle fullscreen , F11 can also be used. This is one of the default keyboard shortcuts: to change the action hotkey,
go to main menu Edit >> Command Mapping.

Upper Panel: Tabs

Luxriot EVO Monitor application upper panel with tabs

The upper panel contains tabs that allow you to quickly switch between main software functionality. The following
tabs may be available, depending on the software version and configuration:

Live: real-time video streams with PTZ controls, data overlay and instant playback
Playback: recorded video stream investigation
Sequence: advanced analysis of the recorded video streams
Smart Search: quickly find the target scene using motion search
Alerts: generated alerts and information level messages
Library: exported video clips and snapshots
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Video Wall*: video wall display configuration
Reports: create diagrams and heatmaps based on the collected metadata
LPR**: investigation of the license plate recognition results
FR**: investigation of the face recognition results
Camio**: investigation of the results received from Camio cloud service
Data Sources**: investigation of textual data received from configured external data providers

*The tab only appears when Luxriot EVO Global server connections are present, video walls exist in the Luxriot EVO
Global configuration and the used user account has sufficient privileges assigned via Luxriot EVO Console.

**The tab only appears if corresponding service is supported by Luxriot EVO license, the service has been set up via
Luxriot EVO Console and the used user account has sufficient privileges.

When all tabs do not fit in - either because of smaller screen size/resolution or due to decreased application window
size - tab items are collapsed to icons. Tooltips will provide clues

Upper Panel: Server Connections

The Luxriot EVO Monitor application Connection button on the upper panel

The Connection button opens server connection setup window and also displays the number of currently configured
servers.

Upper Right: Main Menu

Luxriot EVO Monitor application main menu

This section contains the main application menu items.

File
Exit: close the Luxriot EVO Monitor application

Edit
Settings: application settings
Command mapping: keyboard shortcuts
Theme: application appearance management

View: operation modes and application view management
Time presentation: choose between local, UTC or specific server time zone
Operation modes:

Always on top
Exclusivity mode
Locked application           

Tools: utilities related to Luxriot EVO Monitor application management and other tools
Import Settings: load application settings from file
Export Settings: save current application settings to file
Archive Backup Wizard
GPU Configuration Wizard
Administration Tool       

Help
User Guide: opens the Luxriot EVO Monitor application user manual
About: about Luxriot EVO Monitor
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Left: Resources

The Resources panel of the Luxriot EVO Monitor application

This section displays resources from the connected servers: layouts, channels and maps loaded from configured
servers. If visual grouping has been configured for the target server, the resources will be arranged into expandable
lists. Visual groups (looking as folders) can be dragged and dropped onto the viewing area whole.

The panel can be docked to the left by pressing the << arrows in the top part of the panel, and restored back by
clicking the >> arrows; individual resource lists can also be collapsed and restored by clicking the subsection name.
Search field in the upper panel part allows you to filter the resources based on the entered text.

Search: global resource search
Layouts

Layouts, layout templates and layout sequences
Local resources: stored on Luxriot EVO Monitor machine
Server resources: loaded from connected server(s) (shared layouts and server-side layout
templates)

Channels: per server or mixed, if Merge resources option has been enabled in the server connection
properties

Unavailable channels are marked red
Among regular video channels, there are also CrossLink channels: interactive and non-
interactive webpages (server-side) and workstations

Maps*: e-maps, per server or mixed
User Buttons*: software buttons that perform actions, associated with them via Event&Action scenarios;
per server or mixed
Webpages: interactive webpages (no recording)

*Some resources may be unavailable for certain software editions.

Channels, maps, webpages and user buttons can also be grouped independently through the Visual Groups
functionality of Luxriot EVO Console. Visual groups can have one or multiple levels, i.e. each visual group can
contain other visual groups, allowing you to create more complex organisation of your channels and other resources.
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3 About

Information about the currently running Luxriot EVO Monitor software version can be viewed in following way: in
Luxriot EVO Monitor, go to the main menu, click Help and select About. This dialog box also contains links
to Luxriot website and technical support email for your convenience.

Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.2.0 or 1.4.0.

Maintenance versions within the same major version (e.g., 1.3.0 and 1.3.1) are compatible but we still
recommend that you match the software versions exactly for best performance.

Note that there is no information about the server license here as Luxriot EVO Monitor application can be connected
to several different servers at once. You can retrieve the server license details locally on each server.

Help -> About

Luxriot EVO Monitor User Guide

©2023 A&H Software House. All Rights Reserved.

8



4 License Limitations

Please note that, as Luxriot EVO Monitor application is a unified interface for all Luxriot EVO editions, some
features described further in this document may not be available for certain Luxriot EVO server versions.

When the Luxriot EVO Monitor is connected to a server that is operating with a free license, the
following limitations apply:

each Luxriot EVO Monitor application can be connected to a single free server at a time
each free server can have no more than one simultaneous Luxriot EVO Monitor connection
some types of the resources will be not available (e.g., video walls, maps, user buttons, external services,
data sources)

 Some features, like video wall, will also be unavailable with Luxriot EVO S servers. Luxriot EVO Monitor
applications connected to Luxriot EVO Global server(s) will provide full functionality.
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5 Server Connections

The main purpose of the Luxriot EVO Monitor application is to display the contents of the local and/or remote
server(s). By default, Luxriot EVO Monitor contains a local server connection entry when it is installed together
with the server.

General client-server connection logic is:

use server IP or hostname and TCP (VMS) port as configured on the server side
user account must have enough privileges to connect and retrieve the resources
additional security settings may affect the login procedure, e.g., you may need to enter the login reason or
use two-factor (2FA) authentication to confirm your identity

You can connect to multiple Luxriot EVO servers of different editions within the local network or over the
Internet, using built-in Luxriot EVO users or AD/LDAP domain users (pre-configured on the server side). In the
Luxriot EVO Global system, you simply need to enter the central management server address, and all the
Luxriot EVO Recording Server and mirroring server connections are established automatically. If the Luxriot EVO
Global server goes offline, your Luxriot EVO Monitor application will be redirected automatically to the mirror, if it
exists; if not, the Luxriot EVO Recording Server connections will still be available (without enterprise features
provided by Luxriot EVO Global server).

The list of servers can be saved into a file for further distribution on other workstations via main menu Tools >
Import/Export Settings. This, you can enter the list of server connections with all required user accounts, save it,
and then import the file on other client machines. All settings are stored, except from the user passwords - for
security reasons, the passwords are not kept. You will only have to enter them once after importing the server list.

The Luxriot EVO software edition allows a maximum of 1 (one) simultaneous connection to the server; Luxriot
EVO Monitor can also only be connected to one Luxriot EVO server at once. Other software editions have no
limitations in this regard.

One concurrent connection to a server is maintained at a time to optimize the network traffic. For certain use
cases, you may want to create multiple connections to the same server with different credentials (having
different permission sets) without saving the passwords and ask each user to choose his profile and enter his
password when starting his session. To ensure that no person uses previous user's session, there is an auto
logout option after certain period of inactivity, which can be enabled in the application settings.

Connect to Luxriot EVO Server

To connect to a Luxriot EVO server via local or public IP or hostname, follow the steps below.

Click the Connection button in the upper panel to bring up the dialog box.
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Open the Connection section from the upper panel

Click the + Add server button to create a new server connection and fill the connection parameters. Alternatively,
choose Edit to adjust the existing server connection settings.
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Add new server dialog box

The table below contains details about the available parameters.

Setting Description Default
value

Server title User-defined server name Server #N

Server IP address Local/Internet IP address or host name of the target server localhost

Server port TCP port for remote connection 60554

User name User account name for remote connection admin

User password Password for the provided user profile [empty]

Domain AD/LDAP domain, if applicable [empty]

Multicast mode Accept multicast streams from the target server (must be enabled on server
side)

Disabled

Merge resources Do not display the source server for accessed resources; shuffle server
resources (for multiple servers)

Disabled

Click Save when you have finished. The server connection created will appear in the item list and Luxriot EVO
Monitor will attempt to establish the connection immediately. Click Disconnect if you do wish to start working with
the target server later.

For you to be able to use the multicast mode, it must be enabled on the server side via Luxriot EVO Console.
Also, multicast traffic must be allowed on all the network equipment on the way from your server to the
Luxriot EVO Monitor.
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Click the Remove button in the upper-right-hand corner to delete any existing server connection.

Available connection list

Select a server by clicking it in the list and click Connect in order to (re-)establish a connection with the selected
server. Server resources will automatically appear in the left hand panel.

In the Application settings, it is possible to set up automatic logout after a certain period of user inactivity. If
this setting is enabled, all the servers will be disconnected from if there is no user activity in the application
interface; default inactivity period is 15 (fifteen) minutes.

Also, for enhanced security: in the admin tool, you can disable the Remember password option, forcing users
to enter the password when they connect to any server every time.

If you chose not to store the password, you will be asked for it every time you re-connect to the target server. In
that dialog box, you will also have an option to change the user domain - you can use a domain that is different from
the one used in the current Windows logon session.

When you do not see an option to remember the password, it means your administrator has disabled this
functionality. In this case, you will have to re-enter the password every time.

If your user account does not have a privilege to log into Luxriot EVO Monitor application without entering login
reason, you will be also asked to provide a justification for this server session. The entered text will be logged in the
server audit log. This is an additional security feature and it can be disabled by adding the corresponding user
permission in Luxriot EVO Console, under Administration profile in the user account settings.
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Specify the password to establish the connection with the target server

Server policy of the Luxriot EVO server may limit the number of login attempts. If you enter a wrong password
more than the number of times specified by that policy, your user account will be blocked. Your system
administrator can unlock the user account via Luxriot EVO Console.

Click Disconnect in this same dialog box to log out from the selected server.

Two-Factor Authentication

This application supports two-factor authentication as an additional security measure for the user login. It does not
eliminate the necessity to enter the user password; instead, it serves as an additional security layer.

If the target server has two-factor authentication (2FA) policy enabled, you will be asked to confirm your identity by
requesting and entering a code. Depending on the server configuration, the code may be requested by email or by
SMS.

2FA is configured by the Luxriot EVO server administrator, so if you have any issues with requesting,
receiving, or entering the code, contact the person who maintains the target Luxriot EVO server. Provide the
server administrator with your valid email and full phone number.

The 2FA settings affect all users and all clients by default; the system administrator can set up exceptions for
localhost connections and also for individual users.

The login procedure with 2FA is as follows:

an additional dialog box pops up upon the server connection attempt
choose one of the provided verification methods and click Request code
in the next dialog, you will see a session ID and an empty box
check your email or phone (or other provided verification source) for a message with the same session ID
(for example, marked as #6708 here) and copy the code from the message body (1234 here)
click Submit code: if everything is OK, you will be logged in

The verified session will be active until you log out manually, close the Luxriot EVO Monitor application, or
your session expires after a period of inactivity. If the target Luxriot EVO server disconnects for some reason, the
session will be restored automatically, and you will not be asked to request the code again.

Luxriot EVO Monitor login using two-factor authentication

If you have trouble receiving the code, please ask your Luxriot EVO administrator to check the settings for you.
Possible issues may be:

your email/phone number is not specified in the system or it is incorrect
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the automatic email is filtered - check your Spam folder
your phone has a spam filtering app
make sure you are entering the code itself, not the session ID

You have a limited time interval to enter the code. When the code expires, you will need to request a new one. Your
system administrator can adjust the code validity period.
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6 Application Settings

Luxriot EVO Monitor settings let you define the appearance and behaviour of the application, as well as pre-define
some defaults, such as video and snapshot export defaults.

Application settings are reachable via the main menu by clicking Edit -> Settings, and these cover all configurable
options of the program GUI. Note that parameters here are defined for the whole application and cannot be set
separately for application instances and/or individual layouts, channels etc.

These settings can be saved into a separate configuration file and later imported in any other Luxriot EVO Monitor
application, including application instances on other workstations. The export/import procedure is described at the
end of this topic.

General

General settings like the application language, automatic logout, exclusivity mode parameters etc. can be found here.

General section of application settings

The table below contains a detailed description for each setting.

Setting Description Default Value

Language Choose language for the application interface from the list of available
localizations (requires application restart); will affect both Luxriot EVO
Monitor and Luxriot EVO Console applications, if installed

Language set
during
installation,
English by
default

Application
startup mode

Enable the application to be started in the specified mode
(locked/exclusive/both/none); regular = no special mode

Regular

Interactive
user idleness
action

Override or allow OS screensaver System Settings

Auto logout
after user
inactivity

If enabled, all the servers will be automatically disconnected after a certain
period of user idleness

Disabled

User idleness
timeout

Time period in minutes, after which the auto logout will be executed 15 minutes

Pop up
message box

If enabled, you will get a floating message box with details every time a server
is disconnected

Disabled
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upon server
disconnect

Exclusive
mode*

Defines if exclusivity mode is applied to all monitors or currently opened
application instances only

Opened screens
only

Exclusive
mode
password

User-defined password for unlocking exclusivity and locked application
modes

[none]

Enable
watchdog

Turn ON application behaviour monitoring: Luxriot EVO Monitor watchdog
will restart the application if it freezes or hangs during operation or on
startup (it is highly recommended to keep the watchdog enabled)

Enabled

Show update
notifications

Enable application update notifications from connected servers Enabled

*Exclusivity mode settings:

All Monitors mode will force fill all displays with child Luxriot EVO Monitor application instances upon
enabling exclusivity mode
Opened screens only mode will still allow background application/OS access via displays where no Luxriot
EVO Monitor is launched

Important: Luxriot EVO server and Luxriot EVO Monitor application major versions must match. Example:
Luxriot EVO Monitor having version 1.3.0 will be unable to connect to servers having versions 1.5.0 or 1.15.0.

Maintenance versions within the same major version (e.g., 1.17.0 and 1.17.1) are compatible but we still
recommend that you match the software versions exactly for best performance.
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Usability

This section contains settings related to the application controls and interaction with the application elements:
different playback modes, DPTZ etc.

Setting Description Default
Value

Show tooltips Show hints when hovering over some element with the mouse cursor Enabled

Auto-expand
server nodes

Automatically expand the contents of the connected servers in the resource
tree

Enabled

Auto-expand
visual groups

Automatically expand the contents of the existing visual groups in the resource
tree

Disabled

Show alarm pane Enable to bring up the alarm pane containing bookmark alarms from
connected servers

Disabled

Maintain original
aspect ratio

Keep original picture proportions; when OFF, image will be stretched to fill in
the viewport (this setting can be overridden for each individual viewport)

Disabled

Pause decoding
for background
channels

If enabled, decoding for background channels will be terminated when one of
the channels is maximised*

Disabled

Pause data
transmission for
background
channels

If enabled, streaming will be paused for the rest of the channels when one
channel is maximised*

Disabled

Default
substream mode

Default state of the substream toggle when the channel appears in the
viewport. High = force main stream, Low = force substream, Auto = let
software decide based on viewport size

High

Default DPTZ
mode

Choose how digital PTZ behaves by default: region mode or PTZ emulation Region

Show timestamp Display the server/client time as channels overlay in the top right corner of
each viewport

Enabled

Show
milliseconds

If enabled, the timestamp overlay (top right corner of every viewport) will have
milliseconds in addition to hours, minutes, and seconds

Disabled

Show decoder
information

Show whether and which GPU is currently used for live video decoding Disabled

Extend layout
sequence
duration upon
user interaction**

If enabled, each user interaction with the layout contents resets the sequence
duration countdown to the specified number of seconds IF the remaining time
is shorter

Disabled

Interaction with
map markers

Choose how you want to activate map markers (channels, links to other maps
etc.): with a single click or a double click

Double click

Enable live
preview on maps

If enabled, you can hover the mouse over channel markers to see the live
channel preview

Enabled

Instant playback
default duration

Default timeline size for the instant playback mode, in seconds 300

Instant playback
rewind

Default amount of time in seconds to "jump back" when switching from live to
instant playback mode

60

Pause instant
playback by
default

If enabled, instant playback will be paused after switching from live view Disabled

Timeline
presentation in
playback mode

Choose whether you want to see the timeline for the currently selected channel
only, optionally with an additional timeline containing all displayed streams'
summary, or a separate timeline track for each channel present in the layout

Selected
channel plus
a summary
timeline
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Preview
thumbnails on the
timeline

Choose which elements appear when you hover the mouse over the timeline in
playback (video thumbnail for timeline and/or bookmarks, or just bookmark
details)

Video frame
for timeline
and
bookmarks

Allow different
layouts for live
and playback

If enabled, the application will stop synchronising layouts between live and
regular playback, allowing you to select a proprietary channel arrangement for
playback by dragging and dropping it onto the viewing area

Disabled

Pause when
playback speed is
decreased

Defines how +/- and mouse wheel behaves when controlling playback speed in
regular playback. Disable this setting if you wish to have contiguous speed
control (one click in any direction increases or decreases speed by one step)

Enabled

Prefer substream
for archive
playback

Use recorded substream for playback, if available; this setting is good for low
bandwidth connections

Disabled

Enable automatic
stream selection

Enable this option if your channels tend to be recorded on different servers
(e.g., failover is in use) and you want to have automatic switching between
streams during playback

Disabled

Notification panel
font size

Font size for the messages appearing in the overlay notification panel 14

External service
event background
opacity

Choose opacity level of the [coloured] events from external services that
appear in the viewport notification area. 0=transparent, 100=opaque.

30

Show images for
external service
results

Keep this enabled if you want to have a thumbnail (if available) alongside with
result received from the connected external services

Enabled

*If decoding/transmission is stopped for the background channels, a certain amount of time is required to restart
the decoding after the foreground channel has been minimised back to its viewport. Thus, enabling this option will
decrease CPU/bandwidth utilisation but increase the delay in presenting the rest of the channels when switching
back from the maximised channel view.

**Example: a layout sequence is played and only 23 seconds are left for the current layout. The user clicks a viewport
to save a snapshot: the sequence continues to play. Now, only 14 seconds are left for the current layout. The user
clicks another channel viewport to save the second snapshot; the current layout countdown is set to 15 seconds
(default setting value) so that the layout does not switch in the middle of the user's action. The countdown will be
reset each time the user clicks again. Finally, the user does nothing and the sequence switches to the next layout.
Note that this setting does not affect the layout duration in the sequence settings.
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Viewport Overlays

Viewport overlays are items displayed on top of the video stream. These are miscellaneous controls, buttons,
statistics and metadata.

Viewport overlay section of application settings

You can assign separate settings to each overlay item. Note that, regardless of application settings, some of the
controls are not displayed if corresponding action is not available for the target device, e.g., the Instant Playback
control item is not shown if there is no recorded archive. The following options are available for each control:

Always ON: always display the overlay element
ON if selected: only display the element when the viewport is selected (yellow frame appears)
Always OFF: never display the element

For your convenience, visual overlay items are previewed on the left side of each setting.

Section Available Items Default Value

General Items displayed in the upper-left-hand corner:
Title (device or resource name)
Close (a control allowing to close the current
stream and free the viewport)
Lock (a control allowing to lock the stream in its
current viewport, making it immune to pop-ups)
User buttons: one or multiple items

Always ON

Display
status

Data displayed in the bottom-left-hand corner of the
viewport:

Writing On Disk (recording status)
Motion Detection (motion presence)
Video Resolution (picture size)
Video Compression (stream video codec)
Video FPS (stream frame rate)

ON if selected
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Video Bitrate (data amount, bits per second)

Display
controls

Controls displayed in the bottom-right-hand corner of the
viewport:

Instant Playback (switch mode)
PTZ Toggle (PTZ and preset controls ON/OFF)
Digital PTZ Toggle (DPTZ ON/OFF)
Motion Detection Grid Toggle (MD grid ON/OFF)
Substream Mode Toggle (switch displayed stream:
main/sub/auto)
Maintain Aspect Ratio Toggle (auto/fill/original)
Export Snapshot (save frame to library)
Add User Bookmark (create bookmark and add it
to the timeline)
Input Audio Toggle (incoming audio ON/OFF)
Output Audio Toggle (a press-to-speak audio OUT
control)
Toggle Notifications Pane (ON/OFF)
Send to Sequence Explorer (switch to sequencing
mode)
Send to Smart Search (switch to motion-based
search)

ON if selected, except for PTZ controls
and Send to Sequence/Smart Search
buttons

PTZ
Controls

Pan, tilt and zoom controls:
PTZ Controls (PTZ functionality ON/OFF
regardless of HUD/classic sphere presence)*
PTZ HUD (Heads Up Display, virtual PTZ sphere)
Iris Slider (iris open/close)
Focus Slider (manual focus control)
Zoom Slider (zoom IN/OUT)
PTZ Toolbar (advanced PTZ controls: presets,
tours)
Classic PTZ Overlay (old style virtual PTZ sphere,
visual alternative to HUD mode)

ON if selected, except for Classic PTZ

Digital
PTZ
Controls

DPTZ and dewarp manipulation tools (OFF by default; when
ON, Picture-in-Picture mode and DPTZ toolbar are ON by
default):

Digital PTZ Controls
Zoom slider (DPTZ zoom IN/OUT)
Picture in Picture (small preview window in the top
left viewport corner when zoomed IN)
Digital PTZ Toolbar (advanced DPTZ controls:
presets, dewarp modes)

OFF by default, except for Picture-in-
Picture and DPTZ Toolbar

Motion
Detection

Show motion detector grid overlay (for software-side MD
and only some device-side MD)

Always OFF

Video
Overlays

Channel shortcuts: interactive colourful links to other
channels (set up via Luxriot EVO Console

Always ON

VCA Server-side video analytics metadata overlaying video
stream:

Zones (detection areas)
Counters (indicators associated with VCA rules)
Objects (all detected entities)
Non-Alarmed objects (those not having triggered
any VCA rules)

Always ON
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Speed (object speed)
Height (object height)
Area (object size, approximate area it takes)
Class (object type according to defined internal
classification)
Identifier (internal VA/VCA engine ID for each
object)
Value* (service-specific value related to
recognition or analysis)

*VCA object value is a service-specific information about the object. The actual value type may differ for different
analysis types. For example, for facial recognition the value will contain subject name and surname, but for LPR -
the car license plate.

These settings are stored in the Luxriot EVO Monitor application configuration file and are preserved when the
application is closed and reopened.

*If you set PTZ Controls (Manipulation) to Always OFF, you will have to use the PTZ Toggle overlay control
in order to enable PTZ functionality in live view. If you disable PTZ toggle overlay button, too, user will have
no access to PTZ from the viewport. In other words, PTZ Controls setting affects actual PTZ manipulation
availability regardless of presence of the visual controls (HUD or classic PTZ sphere overlay).

Library

Library is the folder containing all video files and snapshots exported via Luxriot EVO Monitor application, as well
as related jobs - for example, file copying to another location, including CD/DVD. This section allows you to define
the library path and some other settings.

Library section of application settings

Define the default location for snapshots and exported video to be saved to. The original default location is:

C:\Users\<Windows_User>\Documents\Luxriot EVO Monitor

The only additional setting here is Show "Save file" dialog box: if enabled, the dialog box will pop up every time you
export a snapshot or a video file, allowing you to select a custom file destination every time.

Snapshot Export

Luxriot EVO Monitor supports both single channel and multichannel snapshots (the latter is available from
Playback mode only). Naming settings here affect both types; for multi-frame snapshots, the channel name
$(StreamTitle) will be replaced with the word Multichannel.
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Snapshots Export section of application settings

Set file properties for the exported snapshots. The table below contains a detailed description for each setting.
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Setting Description Default
Value

Snapshot file name File name for exported JPEG snapshots; $(variables) are used for automatic
timestamps and other text macros

Set of
variables

JPEG quality Picture quality, 1 (worst) to 100 (best) 60

Subtitles Hard merged subtitles with configurable font; click the Properties button to
select the subtitle contents and appearance

Enabled

Generate PDF report If enabled, the frame will be saved with details as PDF document Disabled

Always use snapshot
export settings

If enabled, the settings above will be used for all exported snapshots;
otherwise, the user will be prompted for these every time

Enabled

Video Export

Set the default video export settings here. All the file types will be playable by the Luxriot EVO Portable Player
application so it is up to you, which ones to select; the settings affect file size and subtitle type availability. Also,
some of the formats are required for certain features to work: for instance, POS data overlay is only supported as
hard subtitles for MKV format with VP8 compression.

Each format has its pros and cons:

AVI, original format: quickest, small file size, no subtitles or extras
AVI + JPEG compression: allows choosing full/quarter resolution, hard subtitles supported; requires
more time, large file size
MP4: small file size, soft subtitles
MKV, original format: extra small file size
MKV + VP8 compression: medium file size, additional options available (motion blur, time lapse, data
overlay), any subs, takes most time

If you wish to embed the external textual data with the video, use MKV export format with VP8
compression. MKV format also exclusively allows to export video in time lapse mode.

Video Export section of application settings
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The table below contains a detailed description of each setting.
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Setting Description Default
Value

Video file name File name for the exported video; $(variables) are used for the automatic timestamps Set of
variables

Video output
file type

Choose between AVI, MP4, MKV and frame series. AVI

Video
compression

Keep the original compression or use an output-specific compressor. Original
when
possible

Resolution Choose between full and quarter original resolution if regular compression is used Full

Time lapse
(MKV only)

Time (in seconds) to be fitted into one second of output video 60

Include external
data
(MKV+VP8
only)

If enabled, the data source (text) overlay will be embedded with the exported video Disabled

Subtitles Enable hard merged or soft subtitles for the exported video (availability may depend
on the format and compression); click the Properties button to set the subtitle
format and colour

Disabled

Maximum
resolution for
multichannel
export

Limit the multichannel video export from playback mode to this total resolution.
Multiple streams will be then compiled into a single video file, its resulting
resolution not exceeding this value. Options: 2MP/4MP/4K/8K

2MP
FullHD
(1080p)

Always use
archive export
settings

If enabled, the settings above will be used for all the exported video clips, otherwise
the user will be prompted for these every time

Enabled

Sounds

Here, you can enable/disable sounds and choose sounds settings for the server notifications.

When event sending to the clients is configured on the server side, it is merely the sound index number (1-10) that is
set, and different notification sounds can be defined for each Luxriot EVO Monitor application. It is also possible to
disable sound for all or any individual notification.

Sound settings for notifications

Options:

unmark the Enable sounds setting to disable audio notifications (enabled by default)
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for every audio notification (1-10) it is possible to:
set the standard notification sound (default), or
disable sound (select None), or
choose your own .wav or .mp3 file to be played.

Use the Play/Pause buttons on the right to verify that the audio file sounds as desired.

Note that, once you set a custom sound or no sound for some notification, the default sound will become
unavailable.

When an audio notification is triggered during system operation, there is no option to stop it - the whole audio
file will be played back. Keep this in mind when choosing custom sounds. Default audio notifications are quite
short.

Video Analytics

This section contains settings specifically related to the visualization of all kinds of video analytics (VA), and
includes several subsections.

The table below summarizes the settings for the video overlays. Similarly to the common video overlays, three
options are available for each element:

Always ON: always display the overlay element
ON if selected: only display the element when the viewport is selected (yellow frame appears)
Always OFF: never display the element

Some of the elements are not independent, but are rather details of the main overlay element (e.g., class and area are
details of the VA object).

Setting Description Default
Value

Zones Video analytics detection zones Always
ON

Counters VA counters for counting objects Always
ON

Objects Objects detected and classified by video analytics that triggered a VA rule Always
ON

Non-alarmed objects Objects that were detected but did not trigger any VA rule Always
ON

Speed Estimated object speed, if available Always
ON

Height Estimated object height, if available Always
ON

Area Estimated object size, if available Always
ON

Class Object class, as classified by the running VA engine Always
ON

Identifier Object ID Always
ON

Value Detected value, if applicable (LPR number plate or person's name for FR) Always
ON

Additional settings:

Setting Description Default
Value
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Analytics
metadata
item
opacity

The opacity of metadata visuals (bounding boxes etc.) in percents; 0 = fully transparent, 100
= opaque

30

Finally, you have an option to control all colours of all VA object classes, including unclassified and
unknown objects.

To change the target color, uncheck the Random option and click the color on the right, then choose the desired hue
from the palette.

Import and Export Application Settings

Luxriot EVO Monitor application preferences can be saved and exported as a file, so that they can later be used on
other workstations running Luxriot EVO Monitor, or restored on the same workstation after re-installing the
software. When importing, make sure that the Luxriot EVO Monitor version on the target PC is the same or newer.

It is possible to handle the following settings:

Server connections: the list of server addresses, ports and user names, as well as connection properties
Application settings: all appearance and usability settings defined under main menu View >
Application settings plus keyboard shortcuts (see exceptions below)
Local resources: local channel layouts and also layout sequences

The following settings are NOT exported:

paths: video export library and sounds
application themes (export available via themes tool)
administration tool preferences
window settings (multidisplay setup)

To export your preferences, go to the main menu in the top right corner, and choose Tools > Export Settings. A
separate dialog box will pop up.
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Enter target file name and path, and choose what settings should be exported

In the export dialog box, choose the destination folder for the *.lxm file. Below, select what settings will be exported;
by default, all of them are chosen. You can save the settings partially, for example, export the list of server
connections into a separate file. When ready, hit the Export button. After the export is complete, you will get a
confirmation; and, you will get a warning in case the target file cannot be created (e.g., not enough user permissions
to write to the specified location). In the latter case, select a different folder and try again.

 

The import procedure is very similar: go to the main menu Tools > Import Settings, locate the *.lxm file, select
desired settings to be loaded and click Import. Note that the imported usability settings will overwrite the existing
ones, and the resources are imported using the following logic:

layouts and layout sequences with identical names will not be imported - currently present resources have
priority
servers with at least one different connection property (IP/host, port, domain or user name) will be
appended

For instance, when importing a list of servers with the same host name and port but different user names, all servers
will be appended to the connections with their corresponding names. Servers with identical connection properties
but different preferences (merge resources, multicast/unicast) will be ignored (not imported).
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7 Live View Section

Click the Live tab on the upper panel in order to switch to live video monitoring.

The panel on the left displays resources from connected servers: layout templates, layouts, channels, maps and user
buttons loaded from configured servers.

Search: global resource search
Layouts and layout templates

Local resources: stored on Luxriot EVO Monitor machine
Server resources: loaded from connected server(s)

Channels: per server or mixed, if the Merge resources option has been enabled in server connection
properties       

Among regular video channels, there are also CrossLink channels: interactive and non-
interactive webpages (server-side) and workstations

Maps*
User Buttons*
Webpages**: interactive webpages

*Some resources may be unavailable for certain software editions.

**This type of resource requires an additional license.

Depending on the resource type, you may be able to click and/or drag items. See the relevant sections of this manual
for detailed information on how to use and manage each of these resources.

Live view in Luxriot EVO Monitor

From the Layouts menu on the left, select your desired layout template and then drag and drop it into the
viewing area. Next, drag and drop channels from your desired server to the empty slots, using the Channels menu
section on the left. Layout templates can be selected either from default local templates or from server layout
templates. The latter can be created on the specified server via the Luxriot EVO Console management application.

You can save the current layout using the Save layout button in the upper-right-hand corner; it will become
available in the layout list on the left under the target server name. Right next to it, there is a button that can be used
to auto-detect displays, which is especially useful in multi-monitor systems.
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Live view with custom layout

Drag and drop or double-click a channel to place it onto the layout template (double-click works for the primary
window). Channels having no video stream (e.g., camera offline) are marked with red in the Channels section of the
Resources list.

Channel name is displayed in the top left corner of each viewport; the current server time will appear in the upper-
right-hand corner.

Click any live viewport to bring up additional channel-specific parameters and quick controls. Overlay preferences
can be changed via Application settings. By default, these are:

Upper-left: general viewport controls
X - close live stream and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up
camera name
user buttons, if assigned

Upper-right: current time, according to the selected time presentation (server, client or UTC); you can
change it via main menu View >> Time presentation
Lower-left: stream details

recording status: X = not recording, yellow arrow = recording
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS
stream bitrate, KBytes/s or MBytes/s

Lower-right: controls; enabled items are highlighted yellow
instant playback (not available if there are no recordings)
PTZ toggle: PTZ HUD and bottom panel ON/OFF
DPTZ toggle
motion grid ON/OFF
incoming audio ON/OFF (if enabled and supported by camera/software integration)
audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)
substream: auto/main/substream
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aspect ratio (auto/stretch to fill viewport/original)
notification panel toggle
snapshot export to library

Bottom: PTZ controls
Presets
Tours
HUD (Heads Up Display) ON/OFF

Centre: PTZ HUD controls
Pan and tilt arrows
Zoom slider
Iris slider
Focus slider

The currently selected viewport will be highlighted with a yellow frame. By default, the selected viewport will have
more overlay controls. You can use ALT+Left/Right on your keyboard to jump between viewports, and ESC to
deselect (remove yellow frame).

Webpages have their own set of controls.

Click the channel live picture to display additional options

The upper-right-hand corner of live view section contains controls for multimonitor and video wall setup.

On the right side of the application window, there is the alarm pane, which displays the arriving bookmark alarms.

If the pane is hidden, enable it via Application settings: Usability > Show alarm pane
Contained alarms are generated by connected servers (action: create bookmark) and must therefore be
pre-configured by the system administrator
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8 Multidisplay Setup

Click the Multidisplay setup  button in the upper-right-hand corner of the live view, next to the Save layout
button, to bring up the display selection menu.

Luxriot EVO Monitor automatically detects computer display configuration directly from Windows display settings:
click Identify to show the display numbers on all monitors - this will helpful if there is a large number of displays. To
change your multimonitor configuration, go to the Windows Control Panel -> Display -> Screen Resolution.

Multiple display selection

Luxriot EVO Monitor automatically detects which screen it is currently on: this display is marked blue and it is not
possible to create any child windows on it. Click on any other empty display (marked gray) to open a new live view
window there: the child window will be opened maximised, with the display number shown in the application
header. The controls in the upper-right-hand corner give the option to enter fullscreen or to close the extension
windows.

For the multiple display configuration, the following logic is applied:

the main Luxriot EVO Monitor application window acts as a parent window, in the sense that:
child windows for extension screens can be created and closed independently
when the main application window is closed, all other windows are closed as well

the main window can be located on any screen
only one application window can be opened per screen
child windows are maximized to fill all screen
child windows do not have menus or panels, just live view mode
double-click layouts and/or channels to load them in the main application window
drag and drop layouts and/or channels from the main window list to extension monitors

The advanced window settings dialog box offers the following possibilities:

create windows for the available displays and manage their properties
assign default layouts and sequences to windows (local displays only)
bind windows to video wall displays
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Advanced window configuration

In the upper part of the configuration dialog box you can see the available window list. The main Luxriot EVO
Monitor window (marked as Primary) is always present in the list and it cannot be deleted or renamed. More
windows can be added, their maximum number being limited to the number of displays physically connected to the
workstation. For each window, the following items are displayed in the summary list:

display number
primary or not (cannot be changed)
startup layout/sequence, if set
channel/map pop-ups allowed or not
layout pop-ups allowed or not
start fullscreen or not
video wall screen number, if set

All these settings can be changed below.

To add a new window, click the + Add window button in the upper-left-hand corner (when the number of
windows has reached the number of physical displays, the button becomes greyed out). Select the parameters of the
new window and click Save for the changes to take effect.

If you make some window a part of the video wall, the startup layout/sequence setting will be reset and
greyed out, as video wall startup settings should be defined in the video wall management tab.
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9 Keyboards & Joysticks

Luxriot EVO Monitor offers a set of keyboard shortcuts for most interface controls and operations, and also gives
you the option to re-program every single key combination, allowing you to assign your own key combinations to
every available operation (action). This is true not only for the standard computer keyboards, but also for PTZ
keyboards and joystick controllers.

The controller device should be DirectShow compatible in order to be recognized in Luxriot EVO Monitor.

All keyboards connected to the Luxriot EVO Monitor station are automatically detected and listed as available for
shortcut configuration; the list of default shortcut mappings is also attached automatically, if it is available for the
target controller. For PTZ keyboards, joystick functionality is not listed but it is implied that all joysticks have the
same behaviour, which includes pan and tilt on X and Y axes and zoom on Z axis. If you wish to calibrate your
joystick before using it in Luxriot EVO Monitor, please go to the Windows Control Panel and find your device under
Devices (Devices and Printers section).

The list of available commands is the same for each connected controller and cover most of the actions that
can be performed in Luxriot EVO Monitor. Commands cannot be added to the list manually at user's will but it
is likely that the list of the available programmable actions will be expanded based on the customer feedback.

In order to view and edit the shortcuts, go to the Luxriot EVO Monitor main menu -> Edit -> Command mapping.

List of mapped commands

From the Devices drop-down list, choose the keyboard you wish to configure the shortcuts for; if your device is not
in the list, make sure that it is connected to the server and that its driver has been installed correctly. Some devices,
such as standard keyboards, have an extended pre-configured (default) set of command shortcuts covering almost
all the available actions; generic ones have either no default configuration or shortcuts for calling first ten presets of
a PTZ-capable camera. 

In order to change shortcut mapping and replace it with your own key or key combination, simply double-click the
target command and enter your desired key combination from the keyboard. A minimum of one and a maximum of
four keys is expected for the standard keyboard, and a maximum of two keys - for PTZ keyboards or joysticks. If the
entered key or key combination is already used somewhere else, you will be prompted to either confirm the new
mapping or discard the changes and pick another shortcut.

Use the Load Defaults button in the bottom-left-hand corner if you wish to discard all changes for the currently
selected controller and load default configuration instead.

When you have finished with the shortcut configuration, click Save to confirm all changes and close the dialog box.

Luxriot EVO Monitor User Guide

©2023 A&H Software House. All Rights Reserved.

35



10 Viewport Overlay

Each grid cell n live view can be thought of as a 'slot' - a rectangular part of the layout - and it is called a
viewport. Every viewport can accept channel video, user buttons on top of the video, and maps/geo maps.

In addition to the picture itself, every viewport contains detailed information about the video stream, as well as
several quick controls and toggle buttons, including PTZ controls. These elements overlay the video stream,
meaning that the actual video does not contain them and they only exist as a part or GUI for enhanced user
interaction.

The main overlay items are briefly explained below. Also, you will find more details on some of the controls in
the Application settings and in the Video overlay sections.

Live View

The main view with live streams. Video streams will have the most overlay controls; some of them will also be
available for maps and webpages.

Selected viewport with an active live stream

The following overlay controls are available for live view:

Upper-left: general viewport controls
X - close live stream and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up
camera name
user buttons, if assigned

Upper-right: current time on the server from which the device originates (you can change this by going to
the main menu View > Time Presentation)
Lower-left: stream details

recording status: X = not recording, yellow arrow = recording
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS
stream bitrate, KBytes/s or MBytes/s

Lower-right: controls; toggled ON items are highlighted yellow
instant playback 
PTZ toggle: PTZ HUD and bottom panel ON/OFF
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DPTZ toggle
motion grid ON/OFF
incoming audio ON/OFF (if enabled and supported by camera/software integration)
audio OUT: press and hold the microphone to speak (control is present only if the feature
supported by camera/software integration)
substream: auto/main/substream
aspect ratio (auto/stretch to fill viewport/original)
notification panel toggle
add bookmark
snapshot export to library
send channel to sequence explorer (overlay disabled by default)
send channel to smart search (overlay disabled by default; will not appear for channels without
motion data)

Bottom: PTZ controls
Presets
Tours
HUD (Heads Up Display) ON/OFF

Centre: PTZ HUD controls
Pan and tilt arrows
Zoom slider
Iris slider
Focus slider

You can choose which ones appear by going to the application settings. Some of the controls may not appear
because the related functionality is not available or not supported by the integration (e.g., audio, PTZ); the controls
are also subject to the user permissions. For instance, if you do not have permissions to access the channel's archive,
the instant playback button will not appear.

The overlay control set may vary depending on device capabilities and settings. For example:

if no archive is recorded for the target stream, instant playback will not be available
smart search switch will only be available with recorded channels with motion detector data
for PTZ-incapable cameras, PTZ toggle will be absent
substream toggle will not be displayed when device only has one stream
audio OUT will not be displayed if this feature is not supported by camera or is not implemented on
the software side etc.

Overlay elements can be modified in Application Settings, which are reachable via main menu by clicking Edit ->
Settings. Note that overlay parameters are defined for the whole application and cannot be set separately for the
application windows and/or individual displays.

Notification Pane

Live view has its own notification panel for each channel, which can be turned ON and OFF by using the
notification panel toggle control in the bottom-right-hand corner of each viewport. It contains:

live events from E&A and from external services, e.g., LPR and facial recognition results, and
recent stream errors, e.g., PTZ related errors, which have occurred since the time the channel was opened
for live view.
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Notification panel containing errors for a disconnected stream

You can change the size and position of the notification pane. To do this, long press your left mouse key on the panel
(in any place): a header and a pencil icon will appear on top of the panel. Click the pencil icon to enter to editing
mode.
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Edit the notification panel appearance: size, position, and contents size

You have several adjustments to make here:

click and drag the yellow frame to change the panel size
drag and drop the panel to move it within the viewport
change the Scale setting to make the pane contents smaller or larger

The status below will show if the panel is currently in its original state (default) or has been customized (modified).
Click Done to save the changes, or click Reset to revert the changes to the default appearance. Double-clicking
outside the panel will also apply the changes (similar to Done button).

The notification panel is only available in the live view. If you keep it in the ON state while saving a layout, the panel
will pop up automatically for the target channel next time you open the layout, i.e., the panel state is saved with
the layout.
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Instant Playback

Overlay elements in the instant playback mode are different from those in live view.

Instant playback in a live mode viewport

The following overlay controls are available in the instant playback mode:

Upper left:
X - close live stream and free viewport
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up and may therefore be replaced by other camera at any moment
camera name

Centre: play/pause
click to play
click again or drag to the centre of the line to pause
drag right to go fast forward
drag left to rewind fast
click and hold on the left/right side to change the playback direction
release from dragging to continue normal playback

Bottom right: controls
switch to multichannel playback
go to specific time
toggle motion grid
switch to advanced playback (off by default)
take control (for interactive channels)
create a bookmark with current timestamp
take a snapshot
automatically export current piece of the footage

Bottom: timeline
click any place of the timeline to switch to that point in time
use the <> arrows to adjust the loaded footage time boundaries (which, by default, are the last
five minutes)

drag right to go forward in time
drag left to go backwards in time

the vertical yellow line indicates current playback moment, drag it anywhere or click to move
along the timeline
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Sequence Explorer

Once you have selected a fragment or a set of fragments, the overlay controls in the bottom right corner of the
selection offer the following possible actions:

Magnifier button: make a new sequence out of selected fragments; use the History controls <> in the
upper panel to go back
Play button: play selected footage in archive playback mode
Video button: export video from the selected time range (no additional Set time range window is
displayed)

More detailed control and operation descriptions for the sequence explorer can be found here.

Text Overlay From Data Sources

Textual data from external data sources, if configured, will appear embedded with the live video stream.

Live video stream with text overlay

Metadata Overlay

Bounding boxes with object properties will appear in the video if video analytics is enabled for the target channel.
This may be server-side video analytics (VA) or Open VCA. Also, VCA metadata are supported for some of the
cameras.

You can change the metadata overlay via Application settings.

Channel Shortcuts aka Portals

Channel shortcuts, if pre-configured in Luxriot EVO Console, appear in live view as video overlay elements. Single-
clicking these will pop up the target video channel in the same viewport.
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Shortcuts to other channels in live view

Read more about visual links in the Video overlay section.

Maps

Maps and geo maps have general overlay controls in the upper left corner:       

X - close the map and free viewport - available with or without viewport selection
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be used for
map/camera pop-up
map name

Every map also has interactive markers (per-configured in Luxriot EVO Console):

double-clicking channels* makes them pop-up in the first available viewport (either empty or the first
non-locked one)
maps* links will make the target map pop up in the same viewport
layouts* will also pop up and replace the current layout or layout sequence
double-clicking user buttons will trigger actions, which are associated with them
click a door marker to see the list of available actions

*Remember that every Luxriot EVO Monitor window can be set to accept either individual map/channel pop-ups or
layout pop-ups, but not both. This can be changed in the multidisplay setup. Also, you can change the interaction
mode from double-click to single-click in the Application settings.
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11 Substreams

Substream is a lower resolution video used for reducing Luxriot EVO Monitor PC resource usage (CPU, network) for
live view display. Also, it is possible to play back secondary streams instead of high resolution video on low
bandwidth connections. For example: main stream for recording can be set to 1920x1080 at 30fps and substream -
to 640x480 at 15fps, which would provide much lower load for Luxriot EVO Monitor PC to display video stream.
This allows to have high quality recordings combined with the ability to view many video streams on a low-
performance Luxriot EVO Monitor PC and with limited bandwidth.

Both streams are available for live view and for recording (the latter is configured via Luxriot EVO Console). The live
stream selection is configured to Auto by default, which means automatic switching between higher/lower
resolution streams depending on the image size in order to save network and CPU resources. For instance, Luxriot
EVO Monitor may show a high-resolution stream if you view one camera at a time, but if you go to 4x4 view, Luxriot
EVO Monitor will automatically switch all the cameras to substreams, if they are available. In multi-channel views,
the application compares each viewport size to resolutions of both channel streams and decides, which one is better,
based on similarity to the output viewport size.

Luxriot EVO Monitor application has the following visual indication for substreams in live view as a viewport
overlay item (bottom right):

  Automatic selection between high and low resolution (based on viewport size)

  High quality picture

  Low quality picture (substream)

When no substream is available, the viewport overlay indicator simply will not appear at all for the target channel.

Substreams must be activated on your device via Web browser and, for some devices, this can be also done in the
stream properties in Luxriot EVO Console. Please verify camera performance to make sure substream can be
handled by the camera along with the other enabled features: some devices tend to drop the overall FPS with
the second stream turned ON.

Most cameras provide the second stream as a primary stream image scaled to fit the low resolution. However, some
devices crop the centre of a high-resolution image to fit the smaller frame, and thus the substream picture appears
as if it were zoomed in. Keep this in mind when you are using substream for live view and especially for software-
side motion detector analysis.

If both main and secondary streams are configured for recording, the target channel will be expandable in
playback mode and will have both tracks available for playback.

Substream footage in playback mode
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12 Channels

Channels are resources that contain video data from the Luxriot EVO server. Depending on the channel capabilities
and configuration, each channel may consist of main video stream (hi-res), secondary video stream (substream, lo-
res), audio, motion and video analytics metadata, text from configured data sources (e.g., POS transactions), and
external service data (e.g., facial recognitions).

All channels from the connected servers are listed in the Channels section of the Resources section on the left. If the
server connection has the Merge resources option ON, all resources will be shown together without per-server
grouping. Note that the channels are displayed according to the logged user privileges.

Channels section

Channels are loaded with visual groups, if there are any; otherwise, they are simply listed under the relevant server
name. You can create any hierarchy of visual groups and define their contents via Luxriot EVO Console. Use the
Search filed above the channel list to quickly find a specific channel.

Double-click or drag and drop desired channels onto the layout viewports on the main live/playback window to view
stream contents. For secondary displays, use drag and drop method only.

When you double-click channels in live/playback view, they fill viewports in the following manner:

first, all the empty viewports are filled - from top to bottom, and from left to right;
then, the filling sequence starts again from the very first viewport.

To remove any channel from live view, click the overlay control X button next to the camera name in the upper-left-
hand corner of the viewport.

Webpage Channels

Webpages are a special case of channels. They provide interactive and non-interactive website contents packed
as video for both live streaming and playback. You can use them for monitoring web services with UI and dynamic
contents. Read more about different kinds of webpages in Luxriot EVO Monitor here.
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Live streaming from a website

To display the webpage channel in the Luxriot EVO Monitor application, locate it in the channel list on the left, then
double-click (to pop it up on the first free viewport) or drag and drop it onto the desired viewport.

Webpages possess some of the regular channels' properties. For each one, you will see stream properties (bitrate,
resolution, frame rate, recording status), and also have overlay buttons for controlling aspect ratio, applying digital
zoom, adding bookmarks, and creating snapshots. If the webpage stream is set to be recorded, you will be able to
access the recordings in the playback and instant playback modes.

Apart from webpage channels, there are also non-recordable (direct) webpages. You will find these it the Webpages
section of the Resources panel.
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13 PTZ

For PTZ-enabled cameras, pan, tilt and zoom controls are available both for live mode. Note that available controls
may depend on selected model and actual camera capabilities.

PTZ control is available in two flavours: HUD and classic PTZ sphere, with HUD enabled by default. Classic virtual
PTZ sphere controls can be turned ON via application settings as described below.

When two or more simultaneous PTZ command requests (either from an action or from direct user input) are
sent at the same time, PTZ priority parameter is used to decide who gains access first. When this happens,
request with a higher priority is fulfilled while request with a lower priority is delayed for ten seconds. If after
ten seconds the higher-priority action is still going on, the lower-priority action is denied PTZ access for ten
more seconds and so on.

If two users or actions with the same PTZ priority level have an access conflict, they will be both granted PTZ
access simultaneously and the order of executed PTZ commands is defined by which of the commands reaches
the device first.

Default PTZ priority for all users, including those built-in and imported, and also for all actions is equal to five
(medium priority). You can assign any user/action a higher PTZ priority (six to ten) or a lower one (four to
zero) by editing individual user/action properties in Luxriot EVO Console. The only exception is the PTZ
tours, which by default have the lowest priority (equal to zero), which means that any user or action can
intercept PTZ control; the tour will go on after the PTZ control from a higher-priority user/action is released.

PTZ control is carried out using the HUD overlay controls or point-to-PTZ style controlling without overlay
elements; it is automatically enabled if the camera has PTZ facilities.

If HUD or classic sphere is enabled, use the overlay PTZ sphere to control camera movement: click and
hold to move the camera up/down, left/right or diagonally; additional controls allow to adjust the
camera's iris and focus, as well as to zoom IN/OUT;
If visual PTZ controls are not enabled, click anywhere on the picture to re-position the camera using
indicated point as a new picture centre (point-to-click style).

When re-positioning a PTZ camera, note that some cameras may have response delay due to heavy device
load, physical distance, network latency etc. Bear this delay in mind when using PTZ and, if necessary, release
the virtual PTZ sphere controls earlier.

Switching Between PTZ Control Styles

By default, HUD style viewport overlay controls are used for PTZ. You can change this by going to the main menu
Edit -> Settings and choosing the Viewport overlays tab -> PTZ Controls section.
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Manage PTZ overlay control settings

You can toggle between two modes:

PTZ Heads Up Display (HUD): on-screen controls overlaying video stream
Classic PTZ Overlay: virtual PTZ sphere with traditional design

One of the two modes can be selected at a time and the selected mode will be activated when you enable PTZ for the
channel of your choice. Either visual control set can be hidden by clicking the HUD button in the bottom right
corner of the viewport; in this case, PTZ can still be controlled by clicking the live video stream.

Heads Up Display (HUD) Mode

The following controls are available in HUD mode:

Pan and tilt arrows
Zoom slider*
Iris slider*
Focus slider*
Automatic focus/iris* (  button on the lower slider end)
Presets and tours
HUD (Heads Up Display) ON/OFF

*Note that some of the additional controls may be unavailable depending on the device integration and capabilities.
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Live view with enabled PTZ and HUD overlay controls

Use the bottom overlay menu for presets, tours and HUD ON/OFF switching.

Classic Virtual PTZ Mode

For users who prefer classic appearance of PTZ controls, an alternatively looking panel is offered. It also overlays the
live view, and is docked to the top left corner of the stream. Classic PTZ sphere has the same capabilities as the HUD
sphere. Apart from pan and tilt buttons on the sphere, zoom, focus, and iris sliders will appear, if the related
functionality is available on the device.

Live view with enabled classic PTZ sphere
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Presets

Click Presets below the picture to view the list of available presets; select any to let camera go to the selected pre-
defined position. To save a preset, adjust the camera position using PTZ controls, then click Presets and choose
Save preset. Enter user-friendly name for your preset and pick a preset to be re-defined from existing preset list,
then click Save.

Note that PTZ presets cannot be explicitly deleted: to remove an old entry, simply replace it with a new one.

Enter preset title and choose slot

Tours

Multiple PTZ presets can be combined to create a preset tour - a series of positions for a PTZ camera to go to
through repeatedly. Each preset in a tour can be assigned a duration period of its own.

Click Tours below the picture and select Create tour to make a new sequence. Before building a tour, make sure you
have created all presets that will be used in the target tour.

Tours are stored on the server and thus are synchronised between different Luxriot EVO Monitor workstations
connected to the same server.

Choose to create a new tour

Add and remove presets by double-clicking them; newly added presets will appear at the end of the tour preset
list.  You can also use Search field to quickly find your desired preset, and the recycle bin icon in the upper-right-
hand corner allows you to remove a selected preset from the target tour.
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Create a new tour

Click a tour preset to change its delay time. By default, each preset has a pause of five seconds, and you can change
that to whatever time period you wish for the camera to continue overlooking that specific position. Next, define a
title for the target tour and enable automatic start, if desired; if you select autostart, the sequence will be launched
immediately after server start.

When you have finished, click Save to add your newly created tour to the list of available tours.

Tour options

To start a tour, click Tours and simply select the one you want from the list; to stop it, click Deactivate tour. Each
tour options - Edit and Delete - can be accessed via the  button next to the tour name.
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14 Digital PTZ and Dewarp

Digital PTZ

Digital pan-tilt-zoom (DPTZ) can be enabled for both PTZ and non-PTZ cameras. This feature provides image
magnification by the means of cropping and enlarging the picture, additionally using the picture-in-picture feature
to display a preview of the whole stream when the original picture is zoomed IN. While it is mostly useful for devices
without optical zoom capabilities, if you do not wish to grant some of your users PTZ control access, then DPTZ can
be also used for PTZ devices. Also, digital zoom can be used for maps.

Last used digital PTZ position is preserved when you save a layout containing a zoomed stream or map.

In order to enable DPTZ in live view or playback, select the target viewport and enable digital zoom by clicking

DPTZ toggle  button on the overlay control panel in the bottom right corner. You can also set DPTZ controls to
be visible by default via Luxriot EVO Monitor main menu Edit -> Settings -> Viewport Overlays tab. 

Live view with DPTZ controls enabled

An additional panel with DPTZ controls will appear below the video stream. To use DPTZ with maps, simply use
your mouse wheel to zoom IN and OUT and then drag to view different parts of the map.

DPTZ and dewarp positions will be preserved when you export a snapshot.
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Digital PTZ Modes

Digital PTZ for video streams has two modes:

region
draw a rectangle on the video by left-clicking and dragging with your mouse
when you release the mouse, the marked area will be automatically zoomed in and a small
preview window (picture-in-picture) will appear in the upper left corner of the video
move the selection in the preview window to view different areas
use the mouse wheel either in the preview or in the original video to zoom IN/OUT

PTZ imitation
zoom IN/OUT by using your mouse wheel
when the picture is zoomed IN, a small preview window will appear in the upper left corner of
the video
move the selection in the preview window to view different areas
additionally, you can move around the video by clicking the original video as if it were a PTZ
camera (click and hold to move in that direction)

The basic difference between the two modes is the method of moving around the picture: either by drawing new
regions or with PTZ Point-to-Click imitation. By default, the region mode is enabled, and you can switch between
the two using the buttons on the right side of the DPTZ panel (RGN for region and PTZ for point-to-click mode,
correspondingly).

DPTZ Presets

Digital PTZ positions can be saved as presets and then called later at any time, just like regular PTZ presets. Use the
Presets drop-down list in the left part of the DPTZ panel for this:

to save the preset, click the arrow and click Save preset, then choose whether you want to create a new
preset or overwrite an existing one, specify the preset name and click Save
click the preset name in the list to load it
click the ... button next to the preset name and choose Remove preset to delete it

Digital PTZ presets are stored locally, on the Luxriot EVO Monitor application side, and are bound to channels. This
means that, once created, DPTZ presets will be available for the target channel from the same workstation and they
cannot be shared with other application instances connected to the same server from other places.

Dewarp

For cameras with fisheye and Panomorph lenses, dewarp mode is enabled when digital PTZ is turned ON. This

feature can be used both in live view and playback mode; in order to use it, click the DPTZ toggle  overlay
control in the bottom-right-hand-corner of the viewport.

By default, region dewarp mode is turned ON: a part of the dewarped image is displayed in the viewport and
camera becomes a virtual PTZ, which can be zoomed and moved through the entire angle that fisheye camera allows.
Press left mouse button and drag to pan/tilt in corresponding direction; use the zoom slider to zoom in and out. 

You can place one channel into multiple viewports on your viewport layout, enable DPTZ for all of them and then
use DPTZ to display different regions of the dewarped image. The created arrangement can be saved just as usual,
via Save Layout menu in the upper-left-hand corner: DPTZ positions will be maintained when you load the layout at
any time later.

Choose dewarp mode from the drop-down list
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If you need a larger part of the scene to be displayed in a single viewport, you can switch to a 180-degree or a 360-
degree panorama view using the drop-down menu, which appears in the bottom of the viewport when DPTZ is
enabled.

If you do not have a dewarped picture after enabling digital PTZ capabilities, it means that dewarp has not
been configured for the target device. In order to do this, go to Luxriot EVO Console and adjust dewarp
settings in the channel properties; the details about setup are available in your Luxriot EVO server
management documentation.
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15 Audio

Using Luxriot EVO Monitor application, you can listen to audio streams from cameras, play back recorded audio, as
well as talk back to the cameras. Recorded audio streams are also available when you export the recordings.

Two-way audio is also supported for the Luxriot EVO Mobile application; please refer to the mobile application user
guide.

In order audio stream to be available in Luxriot EVO Monitor, there are a few conditions:

the device, from which your selected channel originates, must be capable of sending/receiving audio
and this feature must be enabled and set to G.711 codec via device Web interface.
the device, from which your selected channel originates, must have audio support implemented in
Luxriot EVO; please contact Luxriot if you have doubts.
audio function must be enabled for the target channel via Luxriot EVO Console, please check the
settings via Luxriot EVO Console according to the Audio section of the Luxriot EVO administration
user guide.

Without these, audio IN/OUT controls will not be available for the selected channel.

Make sure that the speakers and the microphone on your workstation are properly installed and are operable
in order to be able to use the audio functionality in Luxriot EVO Monitor.

Live View

Audio IN/OUT toggle overlay controls are enabled by default for the live view and become available when you select
a viewport by clicking on it. You can change this preference via Luxriot EVO Monitor main menu by going to Edit ->
Settings: you will find the related settings in the Display controls section of the Viewport overlays tab. The available
display options are: always show the overlay control, show only if the viewport is selected and disable the overlay
control.

Audio overlay controls in Live view
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By default, live audio is OFF; in order to listen to the incoming audio, click the speaker overlay control so that it
becomes yellow: if audio functionality has been enabled on the device side and in Luxriot EVO Console, you should
be able to hear the sound coming from the target device.

In order to send some audio back to the camera, press and hold the microphone overlay control (it will also turn
yellow, indicating that reverse audio is active) to speak, then release the control when you have finished speaking.

Playback

If a channel has incoming audio recording enabled, it will be displayed in the archive playback mode. On the
timeline, recorded audio is denoted by a blue line, which slightly wider than the white line (video stream) and the
cyan line (motion).

Audio in playback mode is displayed as a wide blue line

By default, audio is muted; in order to enable it, select your desired channel simply by clicking on the picture
(viewport) and then use the speaker overlay control to turn audio ON. Note that the overlay control will only be
available if there is some recorded audio for the selected channel. Then, start playing back the recordings as usual to
play both video and audio streams. Use your Windows volume mixer to adjust the sound volume.
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16 Motion Overlay

Click on your desired viewport and use the motion icon control in the bottom right corner to switch the motion grid
overlay ON and OFF. This will only work if motion detection is enabled for the selected channel.

Live view with motion overlay on a channel with software motion detector enabled

If the motion detector is turned ON for the channel, you will be able to generate motion frequency heatmaps via
Reports tab.
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17 Instant Playback

Interactive live view mode gives you the opportunity to browse the archive right in the same viewport, without
having to switch to the playback mode. This allows you to view recent footage for selected channels, while still
having live view displayed for other devices. By default, footage is loaded for the previous five minutes and the
playback starts five seconds before the current moment; use the <> timeline boundary controls to change time
range by clicking and dragging mouse to the right (zoom in) and to the left (zoom out) of the <> arrows.

This mode is only available for channels that have recording enabled.

To enable instant archive playback, use the Play button overlay control in the bottom right corner of the live
viewport. The channel will automatically switch to playback mode, allowing you to select timestamps, create
bookmarks and export snapshots/video clips. To exit instant playback mode, use X in the overlay controls' bottom
right section.

Instant playback mode can be enabled for one, multiple or all viewports in the current layout: you can switch
between live and instant playback viewports without any limitations. This archive presentation mode is also used
when investigating data from external services and from data sources in the corresponding Luxriot EVO Monitor
tabs.

Instant playback mode

Luxriot EVO Monitor User Guide

©2023 A&H Software House. All Rights Reserved.

57



The following overlay controls are available in the instant playback mode:

Upper left:
X - close the stream and free viewport
viewport lock status: unlocked (default) or locked; unlocked means that the viewport can be
used for map/camera pop-up and may therefore be replaced by other camera at any moment
camera name

Centre: play/pause
click to play, click any place in the viewport to pause/play (like on Youtube)
drag to the centre of the line to pause
drag right to go fast forward
drag left to rewind fast
release from dragging to continue normal playback

Bottom right: controls
Play button: switch to regular multichannel playback (current layout will be used)
go to a specific time (keyboard shortcut: Space)
create a bookmark with current timestamp
take a snapshot
export loaded footage as a video clip (current timeline boundaries will be used)

Bottom: timeline
use your mouse wheel to zoom the timeline in and out (mouse position will be used as centre)
use the <> arrows to adjust the loaded archive time boundaries (which, by default, are the last
five minutes)

drag right to go forward in time
drag left to go backwards in time

the vertical yellow line indicates current playback moment, drag it anywhere or click to
move along the timeline
the narrow white horizontal line shows recorded video
the cyan line (a little bit wider than the white one) indicates motion
the blue line (a little bit wider than the cyan one) shows recorded incoming audio
the wide transparent white line denotes VCA metadata
bookmarks look like little coloured flags on the timeline, colour depending on the severity level

Instant playback mode has two configurable settings: default duration and rewind time:

default timeline duration is the interval size for the footage presented in the instant playback mode,
default: five minutes (300 seconds)
rewind is the amount of time for the playback to jump back before "now" (the moment when the instant
playback mode was enabled), default: five seconds

Both values can be changed via Luxriot EVO Monitor Application Settings.
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18 Layouts

Layout is a pre-configured viewport configuration with channels assigned for live view and archive playback.
Layouts are created by filling a layout template with video channels. There are two main groups of layouts: local and
shared.

Local layouts are created and stored locally on the same computer where the Luxriot EVO Monitor is installed; these
are not available for other machines connected to the same server. However, local layouts can be exported and
then used on other workstations: to do this, simply select Local resources when exporting application settings via
main menu Tools > Export Settings.

Shared, server-side layouts are kept on each server and are available for all users that are connected to the same
server from other client computers. If the license limits the client connection number to 1, layouts can still be shared
between non-concurrent client connections from different machines.

Layout template is a grid-like viewport pattern without any channels bound to it. There is a set of default layout
templates stored locally with each Luxriot EVO Monitor installation; also, user-defined custom templates can be
created via Luxriot EVO Console. Layout template with the channels assigned to viewports can be saved as a layout.

Layouts section

Drag and drop your desired layout template from the Resources menu on the left - either from the default local
templates or from pre-configured layout templates available under connected server. Template will be empty; drag
and drop channels from the relevant section of the menu on the left onto the layout viewports to fill the grid with
cameras. Channels' contents will be loaded automatically if it is available. You can also use maps and webpages in
any layout.

Click the layout menu  button in the upper-right-hand corner - just above the layout -  and select Save Layout
to save channel configuration as a new local or shared layout, or to overwrite any of the existing ones.
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Save layout: regular or shared

There are the following additional options:

Choose Save Presets if you wish to save the last activated preset for a PTZ capable camera together with
the layout. If you do, the preset that was used for the PTZ camera will be remembered and loaded together
with the layout, overriding any PTZ position changes, which have been made by any other user/action.
To make the newly created layout available to any user connected to the same server, enable the Shared
option in the layout properties and choose your desired settings: target server and layout group. Users who
have the View permission for the target layout group will be able to see and use your layout; users with the
Administer permission will be able to overwrite your layout using the same name.

Click the Expand  button next to the local layout name in the Resources list to remove the layout.

You need at least one layout group to exist on the target server for you to be able to create shared layouts.
Also, your currently logged user must have permissions to administer the target layout group.

In order to add layout groups, log into the target server via Luxriot EVO Console under an administrative
account and go to Layouts section; details are available in your server administration user guide. Note that
there are no built-in layout groups.

Together with the layout, the following parameters are saved and loaded for each viewport, both for local and
shared layouts:

channel/map/webpage position within the layout template
digital PTZ position
aspect ratio
notification panel
PTZ preset (if enabled when saving PTZ)

The layout menu also allows you to send the currently displayed layout to any of the pre-configured video wall
components. Click the layout menu  button in the upper-right-hand corner and select Display on and then
choose desired video wall and target display number.
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Click the Expand  button next to any layout in the list to bring up the layout menu. From here, you can:

delete the target layout, or
send the target layout to the video wall screen.

Note that created layouts cannot be edited: if you wish to change the layout contents, load current layout contents by
dragging and dropping it on the live view, make desired alterations and then overwrite existing layout by saving the
current layout under the same name.
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19 Layout Sequences

Multiple layouts can be organized and saved as dynamic sequences, i.e. 'layout slideshows'. Each sequence consists
of two or more successive layouts, either local or shared. Each layout can be set to stay on the screen for a certain
amount of time.

Saved sequences can be exported into a file via main application menu Tools -> Export Settings and then loaded on
other workstations via Tools > Import Settings by selecting the Local Resources option.

To create a sequence, click the  button near Layout sequences in the resource explorer on the left.

Layout Sequences

The Create sequence dialog box will appear.

New layout sequence dialog box

Double-click layouts or drag and drop them to add/remove layouts to/from the sequence. For each layout, the
pause time can be specified separately, with the default layout duration being 15 seconds. You can add each layout
once or multiple times to appear in the sequence. If necessary, use the Search field in the upper-left-hand corner to
find a layout by name. It is possible to use both local and shared layouts.
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Enter a name for the new sequence and then click Save. The sequence will appear in the resource explorer under
Layout sequences; drag and drop it onto the view area of any window or double-click the name to activate it for the
main application window. The sequence will then start automatically; sequence controls will appear above the
viewports, allowing you to switch between layouts manually and play/pause; also, the panel will also show the
remaining time for the layout that is currently displayed. If there is no connection to the server and shared layouts
cannot be loaded, the message on the panel will say "Retrieving layouts"; as soon as the connection is established,
the target layout(s) will be displayed.

Sequence controls in Live view

Click the |< and >| arrows to switch to the previous/next layout immediately; use the pause button to terminate
playing.

To edit a sequence, click the  button near the sequence name in the resource explorer and select Edit sequence;
to remove it from Luxriot EVO Monitor configuration, select Delete sequence. Note that if you delete or modify the
contents of the sequence currently being played, this will not affect current layout slideshow; in order to start the
updated sequence version, simply start it again.

Startup Sequence

Any sequence can be set to start automatically when the Luxriot EVO Monitor application is launched. There are two
available setup options:

for local displays, the startup sequences are defined in the Multidisplay setup
for video wall displays in Luxriot EVO Global, the local startup option is disabled, and the startup
sequence should be assigned via video wall management

To assign a startup sequence to a local display: while in Live view, click the Multidisplay setup button in the top
right corner, then click Advanced to bring up the settings. Select the target window in the list, then choose your
desired sequence from the drop-down list.

Any existing layout or sequence can be set as startup item

Luxriot EVO Global servers also have a video wall feature. In the same dialog box, you have a possibility to assign
any display to be a video wall screen. If you do so, the startup layout/sequence setting will be discarded and
disabled; to assign a startup item for the video wall display, switch to the Video Wall tab of the Luxriot EVO
Monitor application.

First, select the video wall from the resources panel either by double-clicking it in the Resources panel, or by
dragging it from the list onto the upper frame. The video wall thumbnail will appear: click the display you want to
set the startup item for and its current contents will appear below.
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Drag and drop your desired layout sequence onto the bottom screen part: the sequence will be placed on the video
wall screen immediately and you will see a preview. Then, click the menu icon  on the upper right corner of the
preview and choose Set current layout sequence as startup.

Set a startup sequence for the video wall display

Next time the Luxriot EVO Monitor application is started on the target video wall display, your selected sequence
will start playing automatically. To stop it, select Stop layout sequence from the same menu.
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20 Maps

Maps and geo maps configured via Luxriot EVO Console can be viewed in Luxriot EVO Monitor: simply drag and
drop them from the resources list on the left to any viewport or use drag and drop to load them in the main
application window in live or playback mode. Maps fill the viewports just like channels but, unlike channels, they do
not have any footage. One map can be opened in one viewport or in many simultaneously.

Note that this resource type is not available for the free server license.

Map list in the Luxriot EVO Monitor

Maps inside viewports can be digitally zoomed IN and OUT with the mouse wheel and moved around using the left
mouse button (click and drag to move). Double-click inside any viewport with a map to switch to single camera view,
then click again to return to the layout view. Zoom level is preserved when you save the layout with the target map.
The same applies to geo maps, except when a geo map has been locked via Luxriot EVO Console: in this case, you
will only see one section of the geographical map, without an option to move or zoom it.

Both maps and geo maps contain interactive (clickable) contents. These may be channel markers, as well as other
items (described below). You can specify the desired interaction mode via application settings, choosing between
single and double click (you will fin these under main app menu > Edit > Settings > Usability).

A map with live channel thumbnail in the Luxriot EVO Monitor viewport

Channel markers produce live video preview when you hover your mouse cursor over them. Double-click the
channel marker to open the target channel in the first available viewport (either empty or unlocked), or drag and
drop to place the video in an arbitrary viewport. This functionality is not available in the playback mode.
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In the archive playback mode, the map will only reflect markers for the channels that are currently present in the
layout. When a map is maximized (double-clicked to enlarge in a single viewport), all markers will still be present
but playback will be unavailable because there is no video on the screen. Current playback will be paused. Return to
the multi-viewport view by double-clicking the map again to resume playback.

Channel Popup

Any channel shown on a map can be loaded in Luxriot EVO Monitor with a simple double-click (or single click, if
you have change the setting). In order to pop up a single channel from the map:

hover your mouse over the desired device on the map until it becomes highlighted with a pink circle
double-click the target device in order to map it automatically on the first non-locked viewport within the
current layout
change the viewport, drag and drop your desired channel by its title onto to viewport of your choice
if the device stream is already present on the layout, it will blink with a greenish yellow frame

Channel/map popup must be enabled for the target application window in the advanced window settings. You can
reach them by clicking the multidisplay setup button in the upper right corner.

Allow single item and layout popup in the window properties

Markers for the mobile app channels have another interactive feature. They move along the map when the mobile
app is streaming video to the server (GPS data must be enabled in the app and in the map settings). When the
streaming stops, such markers will return to their default position. These can be clicked for popup, just as regular
channels.

Layout Popup

To pop up a layout consisting of several items (channels and/or maps):

with your right mouse button, draw a rectangle over the channels you want to see: click > hold to draw >
release when ready
a layout containing all selected channels and maps will be formed automatically
the layout will pop up on the first workstation display that has layout popup enabled

Make sure to enable layout popup in the window settings for this feature to work. If none of the displays have layout
popup enabled in the window properties, nothing will happen.
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Draw a region with the right mouse click, then release to popup

Other Interactive Markers

Depending on the server configuration, maps can also contain other types of interactive contents.

User button markers placed on a map can be double-clicked to trigger the associated action. The marker will blink
indicating that the action is being executed. This action is similar to clicking a user button in the resource panel.

Links to other maps will lead you to the target map within the same viewport. If included into the selection for
layout popup, as described above, map markers will add the target maps to the layout contents.

Links to shared layouts can be either double-clicked or selected with the right-click selection (one at a time).
Selecting multiple layouts similarly to channels will do nothing; selecting a layout link together with channel
markers will give priority to channels (layouts will be ignored).

Each door marker will reflect the current door status according to the settings defined in the map
configuration. Also, every door marker can be left-clicked to bring up a drop-down menu with associated door
actions, these being: lock the door, unlock the door and temporarily unlock the door.

Other Non-Interactive Markers

Some of the map overlays are purely informative.

Indicators reflect the current state of the server-side indicator objects. Their value may change based on server
events, such as I/O, detector status changes etc.
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21 Webpages and Other Interactive Contents

Luxriot EVO servers provide several types of interactive resources called CrossLink: these can be webpages or
remote workstations. You can drag and drop them onto viewports as regular channels, enable the remote control
and then manipulate the contents. Webpage devices and workstations can be recorded (so they may have some
footage in playback modes), while direct webpages go straight from the source to the Luxriot EVO Monitor
application and allow multiple concurrent sessions.

The main differences between webpages and webpage devices:

webpages go directly to Luxriot EVO Monitor, while devices go through Luxriot EVO servers
so webpages are simple Web contents, and webpage devices are like interactive video streams
webpages are therefore not recorded and do not have any archive, unlike interactive devices
also, webpages can be used simultaneously by many users (independent sessions), and if you close the
viewport with the webpage, next time the base URL will be reopened
on the contrary, webpage devices have user priorities for remote control
channels produced from webpage devices do not have audio but do have two video streams (main/sub),
just like regular video channels

As for remote workstations, these are also server-side devices, and you can think of them as recorded remote
desktop sessions.

Below, you fill find details on how to find and use each type in Luxriot EVO Monitor.

Direct Webpages

These are fully interactive webpages available for browsing, with live view only. You will find them in the Resources
panel on the left, under the dedicated Webpages section. Webpages are not recorded, thus, the streams go directly
from the source to the Luxriot EVO Monitor application(s).

To start, open the Resources section on the left and then drag and drop the desired webpage onto the viewport. You
may want to use a single viewport layout template for better browsing experience. Webpages may be grouped: drag
and drop the entire folder to the viewing area to put all pages onto the layout.

An interactive webpage example 

After the webpage is displayed, you can go ahead and control the page contents simply by clicking the contents
as if the viewport was your Web browser. You can click links, type texts, log into your account etc.
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Due to security reasons the following restrictions apply:

it is impossible to navigate away to another website (domain)*
copy-paste is not allowed
no file download or upload
no pop-up windows or new tabs
no right-click menus

*Navigation to lower level domains is allowed. This means, for example, you can switch between sub-sections of the
website like lv.wikipedia.org and it.wikipedia.org, but you cannot navigate away to wiktionary.org. If there is a
redirect attempt (e.g., you click on a banner) or you try to navigate away from the specified domain (if the link leads
to a different website), a corresponding warning will appear in the Alerts section of Luxriot EVO Monitor.

If you click some button or link on the website and nothing happens, there's a big chance the target page
belongs to another website (domain). Check the Alerts section for warnings.

Use the overlay controls in the bottom right corner to go back and forward in the browsing history, and to refresh
the webpage.

There are no statuses in the bottom left corner of the viewport, as this is not a video stream: the webpage is rendered
on the Luxriot EVO Monitor side.

Sound is automatic and it will start playing if the remote page plays some content with audio. On the right side, the
is a scrollbar, just like in your browser.

Please note that this feature is not a fully-featured browser but rather a facility that enables cross-platform
interaction. Certain restrictions apply. Media-rich webpages may be slower than normal. For feature-rich
browsing, please use regular Web browsers. 

Webpage Devices

It is also possible to set up a webpage on the Luxriot EVO server side so that it is recorded, too. In this case, it is
treated like a regular video source: you will find these interactive webpage channels under the Channels section
of the Resources panel.

Ask your system administrator to configure visual groups so that the interactive channels are separated
from video channels.

Drag and drop any webpage from the list to put in onto the viewport.
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Interactive weather map in Luxriot EVO Monitor

Viewport overlay controls are very similar to those of regular video channels:

top left corner: X to remove the channel, lock to pin it to the viewport, channel name and (optional)
attached user buttons
top right: timestamp or error text
bottom left: stream properties and recording status
bottom right: the usual channel controls + remote control ON/OFF

The remote control toggle is displayed by default and turned OFF. To initiate remote control, click the icon with
the "clicking cursor" so that it becomes yellow. You can now interact with the channel contents.

If, during the remote control session, another user with a higher priority takes over, the control will be
transferred to them. You will be able to resume your session after they stop interacting. A corresponding
message will appear in the channel's notification panel.

You can create snapshots and bookmarks, toggle streams, or switch to instant playback and regular playback as
usual, just like with any video stream.

Use the channel's notification panel to check if there were any errors or warnings (including those about redirects).

The displayed image quality greatly depends on the resolution, compression and bitrate. If you experience any
issues (e.g., the text is unreadable):

try switching the streams (main/substream)
ask your administrator to change the channel settings in Luxriot EVO Console

Remote Workstations
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Similarly to webpage devices, there can also be devices that provide contents from a whole remote machine. You
can think of them as of Teamviewer or RDP sessions. While webpages only display a single page, with the remote
desktop access you can use any applications on the remote machine.

In Luxriot EVO Monitor, you will find these entities in the Channels section of the Resources panel on the left. These
do not have any special icon so we recommend that your system administrator configures visual groups for your
convenience.

Live remote session from Luxriot EVO Monitor using the CrossLink technology

Viewport overlay controls are very similar to those of regular video channels:

top left corner: X to remove the channel, lock to pin it to the viewport, channel name and (optional)
attached user buttons
top right: timestamp or error text
bottom left: stream properties and recording status
bottom right: the usual channel controls + remote control ON/OFF

The remote control toggle is displayed by default and turned OFF. To initiate remote control, click the icon with
the "clicking cursor" so that it becomes yellow. You can now interact with the channel contents.

If, during the remote control session, another user with a higher priority takes over, the control will be
transferred to them. You will be able to resume your session after they stop interacting. A corresponding
message will appear in the channel's notification panel.

Keep in mind that during remote control:

you will be unable to copy and paste text of files from the local computer (remote machine clipboard will
work)
system key combinations will not be sent to the remote PC (use on-screen keyboard or your mouse for
this)
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For example, it you press Alt+TAB during the remote session, your local computer will catch that combination.

You can create snapshots and bookmarks, toggle streams, or switch to instant playback and regular playback as
usual, just like with any video stream.

Important note: this connection use dynamic frame rate. This means, the stream frame rate will be close to
1FPS while there is nothing happening. If the remote user does something visual, the FPS will grow.

Non-Interactive Webpages

Some of the channels may also be non-interactive. For these, the remote control toggle button will not be displayed.
These are regular video streams rendered from an HTML source, and there is no option to change their contents
from Luxriot EVO Monitor. If you only see this kind of webpages, the case may be that there are not enough
CrossLink licenses on the connected server and the channels were configured to use a regular channel license.
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22 User Buttons

User buttons, as well as other types of resources from the connected servers, are available in the Resources panel on
the left. Note that this resource is not available for the free server license.

User buttons in Luxriot EVO Monitor

User buttons are created via Luxriot EVO Console; button behaviour is defined via Luxriot EVO Console using the
Event & Action Configurator.  There are three ways of using user buttons in Luxriot EVO Monitor:

double-click any button in the list of resources to make it trigger the action assigned to it
drag and drop any user button to a live view viewport to make the user button appear as an overlay control
for your desired camera, then click it once at any time to trigger the relevant action
double-click user button markers on the maps (markers are configured via Luxriot EVO Console)

User buttons cannot be added to the viewports that contain maps. Instead, go to the map management section in
Luxriot EVO Console and add user button markers to the desired maps to use them in Luxriot EVO Monitor.

Starting from the software version 1.4.0, multiple user buttons per viewport are allowed.

Starting from the software version 1.5.0, user buttons can be associated with one or more channels so that they
appear automatically in the viewport when live view of the related channel is shown. This can be set up via
Luxriot EVO Console, in the User Buttons section.

Each time a user button is pressed, the corresponding log entry appears in the Alerts section of Luxriot EVO
Monitor.

Alerts on user button pressing      
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23 Video Wall

Video wall configuration in Luxriot EVO is very flexible and it allows you to set up video output in virtually any
physical display combination. Templates for video walls are set up via Luxriot EVO Console and then they become
available in Luxriot EVO Monitor, depending on the permissions of the connected user. Using the dedicated Video
Wall tab, you can easily control the contents of all available video walls.

Note that this functionality is only supported for the Luxriot EVO Global software edition. Connection to a Luxriot
EVO Global server is required for the video wall functionality to become available. If some of your video walls are
hosted on Luxriot EVO Recording Server machines, you still need to connect to the Luxriot EVO Global server from
Luxriot EVO Monitor: if the connection to the central management servers is lost, your client application will
automatically re-connect via mirror (if available) or to the recording server(s) directly. There is no need to enter any
of the Luxriot EVO Recording Server addresses manually.

Video Wall Setup

The idea of the video walls in Luxriot EVO is that you create a layout in Luxriot EVO Console and then assign
Luxriot EVO Monitor application windows to video wall screens in the layout. Afterwards, the whole video wall can
be easily managed from any location.

In this section, we will review the settings for the Luxriot EVO Monitor application windows and see, which ones are
required for the video wall setup.

Advanced Window Settings

To access window setup in Luxriot EVO Monitor, open the Live section, click the Multidisplay setup  button in
the upper-right-hand corner - just under the main menu - and then click the Advanced button to bring up the
configuration dialog box.

Advanced window settings

The advanced window settings dialog box offers the following possibilities:

create windows for the available local displays and manage their properties
assign default layouts and sequences to windows (local displays only)
bind windows to video wall displays

In the upper part of the configuration dialog box you will see the available window list. Already there by default is
the main Luxriot EVO Monitor window (marked as Primary), which cannot be deleted or renamed. More windows
can be added, their number being limited to the number of displays physically connected to the workstation. For
each window, the following items are displayed in the summary list:

display number
primary or not
startup layout, if set
channel/map pop-ups allowed or not
layout pop-ups allowed or not
start fullscreen or not
video wall screen number, if set
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To add a new window, click the + Add window button in the upper-left-hand corner (when the window amount has
reached connected display amount, the buttons becomes greyed out). You can also create additional local windows
by clicking the display thumbnails in the Multidisplay setup menu (before opening Advanced settings).

Window settings

Select the parameters of the new window and click Save for the changes to take effect.

All these parameters can be set for each window (including default primary window) in the dialog box section below
the window list. The following settings are available:

General settings:

Window name: set window title to be displayed in the application title bar of each window
Startup display: select a display to start the target window on (click to highlight with a yellow frame)
Startup layout or sequence: pick an item to be displayed on window startup; select (Default) to auto
fill a 2x2 layout at Luxriot EVO Monitor startup
Start full screen: enable the target window to start in full screen mode; if this is disabled, the window
will start up simply maximized
Allow channel and map pop-ups*: enable video/map popup on the target window as a result of
event/action rule execution
Allow layout pop-ups*: enable layout pop-ups on the target window as a result of event/action rule
execution

Video wall section:       

Video wall screen: select to make the target window a part of the video wall configuration; choose the
video wall from the drop-down list below
Video wall visual element: choose (click to highlight with a yellow frame) a video wall screen to serve as
the target window output
Tiled display: enable to split the target video wall screen into several physical displays
Tiles: select the grid size and click a tile to assign the current window to it

*Pop-up options can be selected one at a time: enabling object pop-ups disables layout pop-ups and vice versa.
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Video wall screen assignment

In order to delete a window, select it in the list and click the recycle bin  icon in the upper-right-hand corner; you
will be prompted to confirm the action. Note that all the window settings will also be removed; once you have
removed a window and clicked Save in the Advanced settings dialog box, the deleted window will also be closed.
You can remove any window, apart from the primary one.

Confirm deletion

Assign Video Wall Screens

Briefly: for each application window, enable the Video wall screen setting in the lower section > select the video
wall from the drop-down list > click the desired video wall screen > save. Window settings are explained in more
details above.

For the video wall to be available here, the video wall template should be pre-defined via Luxriot EVO Console, and
the current user account must have the Manage video wall permission granted. If you have enabled the video wall
setting but there are none in the drop-down list, make sure you have your Luxriot EVO Global server connected and
check its configuration in Luxriot EVO Console.

If you wish to combine several physical displays into one virtual video wall screen (tiling), enable the Tiled display
option on the right, then choose which screen side each display belongs to. Tiled walls are explained fully below.

Tiled Displays

Sometimes, flat panel displays with no bezel are combined physically into one ultra high-resolution surface. Luxriot
EVO Monitor supports such configurations and allows splitting each video wall display into several tiles, and further
assigning of individual tiles to different physical displays. These displays can be driven either by the same or
different workstations: the resulting tiled wall will look the same. Thus, a set (group) of physical monitors (tiles)
form a single video wall screen, which is then used as the contents' destination. The tiles are set up once, and this
configuration layer is then completely transparent for the video wall management: you will simply address video
wall screens later on, no matter if each screen consists of one or more windows.

To enable tiling, first assign all displays to the same video wall screen, then choose different regions (tiles) for each
physical display using the visual elements.
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Tiling example with channel output visualisation

Example: stretch one channel output to two Luxriot EVO Monitor application windows, which run on two different
client machines.

Configuration:

for both windows:
enable video wall in the advanced window settings, as shown above
choose the same video wall and the same video wall screen (e.g., video wall Matrix, screen 1)
enable the Tiled display option
enter 1x2 layout

for Window 1:
choose tile 1 (left)

for Window 2:
choose tile 2 (right)

As a result, Luxriot EVO Monitor will automatically treat two displays as a single screen, and any contents sent to
this video wall screen will be stretched to fill both physical surfaces.

Note that the contents of the tiled displays can be defined via video walls only, either by sending items to the
video wall screens from the item menu (...), or by opening the video wall management tab. If you send items to local
screens (by double-clicking or dragging and dropping them from the resources' list), only a part of the tile will be
used, producing an undesirable effect.

Make sure to calibrate your tiled displays so that they have similar brightness and colour settings. These
settings are usually available via operating system or utilities bundled with the graphics card drivers.

Many different displays can be subscribed to one and the same video wall screen.

Example:

in the office, video wall Screen 1 consists of one physical display, and in the control room the same
output is sent to four displays using tiling
when someone manages the video wall from the corresponding tab, the Screen 1 contents is changed
simultaneously in both places

Both channels and maps can be tiled. However, visual overlay elements (e.g., buttons, portals) will be
unavailable. Text from data sources will overlay the video, as usual.
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Video Wall Management

Once the Luxriot EVO Monitor application windows have been attached to the video wall displays, it becomes
possible to send resources directly to any video wall display. You can do this in two ways: send resources directly
from their menu, or enter the full-featured video wall management mode. The first option is convenient for quick
edits, while the second one allows full control over the video wall contents. Both modes handle video wall screens
and not individual tiles, if the tiled displays are enabled. Thus, you do not need to worry about the tiles: Luxriot EVO
Monitor will take care about them automatically.

Below, you will find guidelines on how to administer video wall contents in Luxriot EVO Monitor.

Quick Content Output

To send any resource directly to a video wall screen, click the Expand  button near resource name in the list on
the left and choose Display on -> Video Wall -> pick video wall -> pick display number/name. Available resources
are: layouts, layout sequences, maps and individual channels.

To send the currently displayed screen contents to the video wall display, do the same thing from the layout
menu in the upper-right-hand corner (above live view).

Advanced Management

Switch to the Video Wall tab on the upper panel to access advanced video all management. In this mode, your
Luxriot EVO Monitor acts as a controlling client for all the video wall members.

Here, in the left-hand panel, all available resources  - both local and server-side - are listed. These are:

video walls: fetched from Luxriot EVO Global servers, each video wall can be expanded to view its
displays
layouts, layout templates and layout sequences: both local and shared via Luxriot EVO Global servers;
new sequences can be created from here by clicking the Expand  button
channels: individual channels from all connected servers
maps: fetched from connected Luxriot EVO Global servers

Video wall management
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First, drag and drop your desired video wall from the resource list to the upper section of the window. You can
drag and drop either the video wall name itself or any of its displays. Video wall display arrangement will appear in
the upper part of the window with its corresponding display numbers and names.

Click any cell to view the current contents of the target display: it will be shown below the video wall arrangement.
The title bar of the lower window part will reflect the video wall display number and name, currently displayed
resource type (layout or layout sequence); in the right-hand side of the panel you will have the layout menu, which
will allow you to quickly set the currently shown layout as startup layout for the target video wall display. If the
current video wall display has a layout sequence on it, this menu will offer options to set the current layout
sequence as startup and also to stop the sequence. "Startup" in this context means the start of the Luxriot EVO
server running the target video wall.

You can set startup layouts and sequences only when Luxriot EVO Monitor is connected to the Luxriot EVO
Global server.

This means, under the following circumstances you will be unable to set startup contents:

when the video wall is kept on the Luxriot EVO Global server but connection to it is lost (mirror
connection still active),
if your video wall is assigned to one of the Luxriot EVO Recording Server machines, but connection
to the Luxriot EVO Global server is lost

You can still manipulate the video wall contents manually in both these cases.

In the lower part of the window, you can manipulate the contents of the target video wall display in the exact same
way as you would do in the usual live view mode. You can:

drag and drop layout templates, layouts and layout sequences from the Layouts section of the Resources
panel on the left
create new layout sequences from the Layouts section
drag and drop individual channels from the Channels section
drag and drop maps from the Maps section
close channels and maps in the layout by using the X button in the upper-left-hand corner of the viewport
swap channels and maps within the layout by dragging them by their titles
lock channels and maps in their viewports by using the lock overlay control in the upper-left-hand corner
digitally zoom channels by using the digital zoom overlay control
digitally zoom maps by using your mouse wheel

Indication conventions:

currently selected video wall screen is marked blue green

the information icon  next to the layout/channel title shows the name of the user who has placed the
corresponding layout/channel: hover your mouse cursor to see the user name
the information icon is highlighted yellow for five seconds after the corresponding resource has been
placed

All changes to the video wall display contents are immediately applied and all other users who are managing the
same display at this moment are notified by the highlighted information icon. If selected arrangements are not saved
as startup layouts, they will be kept until remote Luxriot EVO Monitor applications are restarted.

When your Luxriot EVO Monitor is connected to the mirroring server instead of Luxriot EVO Global (server
colour indicator changes from green to yellowish), all the changes you make to the video wall configuration are
kept on the mirror server. When the Luxriot EVO Global machine comes back, all changes are synchronised
back to the primary central management server. All this happens automatically and transparently for the
Luxriot EVO Monitor users.
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24 Playback (Archive) Mode

Select Playback tab to switch to archive playback mode. Your current layout will be used and recorded video streams
will be displayed for channels with enabled recording. If you wish to load footage from a different channel or
channels, or use a different layout or layout template, use the Resources panel on the left:

Layouts: double-click your desired layout to load it
Layout templates: double-click your desired layout template to load it, then double-click or drag and
drop the channels of your choice to fill the viewports
Channels and webpages:

double-click a channel to load it automatically within the current layout (first, empty viewports
are filled, then non-locked channels are replaced one by one)
drag and drop a channel onto any viewport to load it there

By default, the layout is synchronised with the live view as you switch between Live and Playback tabs. However,
you can disable this synchronisation by allowing different layouts for live and playback in the Application settings,
under Usability (scroll to the bottom to see this setting). For multichannel layouts, all channels will be played
synchronously.

Archive Playback mode

All channels are listed under the servers from which they originate; or, if you have chosen to merge resources in
the connection properties, they will form an alphabetically sorted list. Each channel can be clicked and expanded in
order to access recordings of its main an/or secondary stream, as well as separate tracks recorded on failover
servers. Use the search field on top to quickly find the desired channel.

All the footage having no associated active channels will be available under Orphan archive tracks. Such
recordings include footage from removed channels, renamed channels and also Luxriot VMS archive.

Also, if your current user account does not have permissions for certain channels but has access to a server's
recordings, all channels will be also listed as orphans.

Luxriot EVO archive is protected with watermark. If archive contents has been modified with third-party
tools, a warning will be displayed during playback and a critical level entry will appear in the Alerts section.

Timeline
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The timeline in playback is an outline of the archive recordings, and it is displayed below the video. Depending on
your application preferences, it may look different, but the logic remains the same. Use the timeline and controls
on/next to it to browse through recordings.

The description below will let you better understand how the timeline works and improve your archive browsing
experience by revealing some tips.

Multichannel playback timeline

Stripes on the timeline represent different recorded data streams. Legend:

the yellow vertical line denotes current playback position
time intervals show the timeline scale; click and drag left/right to move the timeline
hover your mouse over the timeline to see a thumbnail (stream/bookmark preview)
use your mouse wheel to zoom the timeline in and out (current playback position will be used as centre)
the narrow white horizontal line shows recorded video
the cyan line (a little bit wider than the white one) indicates motion
the blue line (a little bit wider than the cyan one) shows recorded incoming audio
the wide semi-transparent white line denotes VCA metadata*
the wide dark green one in the background is external textual data
bookmarks look like little flags of different colours (colours for various severity levels can be customized
via Luxriot EVO Console)

Instant playback timeline containing video, external data overlay, and one bookmark

The visualization of data tracks (layers) is non-continuous, with the timeline overlay of the target color only
present during periods containing the corresponding data.

*Earlier Luxriot EVO versions had a continuous timeline stripe for VA metadata. Starting from v.1.20.0,
metadata are displayed similarly to motion, with the timeline overlay only present during periods with
analytics detections.

The video footage outline is shown twice by default: the upper timeline displays the contents of the currently
selected stream, with the corresponding channel name shown on the left; the lower timeline shows a content
summary for all the channels currently present in the viewport layout, both timelines being synchronised. The
second timeline with summary can be optionally disabled via Application Settings. You can also choose to have a
separate timeline for each channel.

 

Timeline selection for export and protection can be created as follows:

1. Click the timeline once to put the playback marker onto the desired starting position

2. Click the selection marker icon  below the timeline to mark the beginning: the corresponding mark
will appear on the timeline

3. Place the  playback marker to the end of the desired interval
4. Click the selection marker again to create the selection
5. Click the selection marker again to discard the selection

Once the target interval has been highlighted on the timeline, you can browse the timeline as usual; the selection will
only be discarded if you click the selection marker icon once again or switch to other tabs (live etc.).

The created selection can be used for archive related actions where it is necessary to choose an interval (e.g., export
video clip, delete or protect a part of the archive).

 The timeline appearance is indicative and not 100% accurate, i.e., gaps in the archive may not be visible at
certain zoom levels. For example, one minute long gaps will not be visible on the two-week scale. To see more
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details, zoom in using your mouse wheel or using timeline controls.

 

Overlays and Playback Controls

The following viewport overlay controls are available in the playback mode:

Upper left:
X - close the stream and free the viewport
viewport lock status: unlocked (default) or locked; unlocked means that the video in this
viewport can be replaced by other camera if you double-click or drag it from the Resources
camera name

Bottom left: stream details
motion detector status: running = motion present, standing still = no motion detected
video codec of the stream
picture resolution, abbreviated
stream frame rate, FPS (only displayed up to 4x playback speed)

Bottom right: controls
audio ON/OFF: disables or enables audio playback
DPTZ controls ON/OFF
aspect ratio (auto/stretch to fill viewport/original)
motion grid ON/OFF

Playback controls

The playback mode controls are located at the bottom of the window:

far right and far left of the timeline:
timeline start and stop timestamps
use the <> arrows and drag left to zoom out/drag right to zoom in the timeline
yellow arrow indicates the location of the nearest footage if it is not present on the timeline at
the time (this can happen, e.g., after zooming the timeline)

playback controls:
use the Play/Pause button to start playback
click and drag along the timeline to move the current cursor position
use the <| & |> arrows near the Play button to go one frame back/forward
-/+ steps: click to go back/forward with a step of 10 seconds, 1 minute, 10 minutes, 1 hour or 1
day
|< >| arrows: go to the very beginning/very end of the footage

playback speed:
during playback, drag the blob to adjust playback speed from +/-0.5x to +/-128x (you can use
mouse wheel for this, too)
the Pause button duplicates the main pause control
when paused, set playback speed to start playing video (without pressing the Play button)

additional controls on the left and on the right of playback controls:
go to the next/previous motion event
I and II markers can be used for selection (for export or to protect/remove footage)
clock button: go to a specific date and/or time
bookmark: add bookmark
camera button: take a snapshot of the currently selected channel
camera with a layout: take a multichannel snapshot
video button: export a piece of video
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The behaviour of the controls can be adjusted via application settings. This includes timeline presentation, stream
selection for playback, as well as preferences for video and snapshot export.

In the application settings, under Usability, you can define how your mouse wheel controls the playback
speed:

contiguous: wheeling in different direction increases or decreases the speed to the next value
pause: decreasing the speed will drop it to zero, pausing the playback

Calendar

Click the Archive Calendar button in the top right corner to toggle an additional panel containing archive calendar
view. This control allows you to see for which dates and time intervals the footage is available, and to switch to some
particular period quickly.

Playback mode with calendar enabled

Units of time (months, days and hour intervals) marked with a blue underline contain footage for at least one
channel currently displayed.

Bookmarks and VCA Event Search

The Bookmarks button in the top right corner opens up an additional panel that allows you to browse the existing
bookmarks. You will find more information on this in the Bookmarks section of this document.

Similarly, the VCA button next to the Bookmarks button in the top right corner provides video analytics event
search functionality (recorded video analytics events from server): please refer to the VCA Events section of this
manual for further details.

Archive Protection and Deletion

It is possible to mark a certain part of the archive and use the selection for further deletion, or protect a part of the
archive from being removed. Special user permissions are required to allow this functionality.

If you choose to protect a specific part of the archive, it will be impossible to erase it from the Luxriot EVO
Monitor application, and that part of the archive will also be ignored by server when applying quotas. To disable
protection, you need to log into the server via Luxriot EVO Console and change the archive protection settings.
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If you choose to remove a part of the archive, it will be erased permanently with all related auxiliary information
(audio, motion metadata etc.). Protected intervals cannot be removed; when such an action is attempted, you will
get a warning in the Alerts section.

When you delete a part of the archive, it is erased immediately. This action cannot be undone. Please
mind applying all the necessary security precautions (e.g., take care of a good administrative account password
and review user permissions) to avoid undesired data loss.

When you protect a short period of the archive (e.g., several minutes), in fact, the whole file containing
this period is protected from erasing. Therefore, intervals adjacent to protected period will also be locked. You
can verify the exact protected interval by opening Luxriot EVO Console >> Monitoring section >> Archive
statistics >> Protected intervals.

General steps for both these actions are:

1. Mark the beginning and the end of the target interval on the timeline using the markers  below the
timeline

2. Use the buttons in the bottom right corner to either remove  a part of the archive or protect  it
from deletion

You can skip the first step and press the delete/protect buttons without any selection on the timeline; then, the last
five minutes of the recordings will be used as the target interval.

Selection on the timeline

All footage that has been protected from erasing can be un-protected via Luxriot EVO Console, by logging with an
administrative user account with corresponding privileges. Until then, the protected part of the archive cannot be
erased by user actions (as described above) or by automatic erasing based on quotas.

Protected archive is excluded from recording quotas and will not be overwritten. Also, such footage is
protected from manual deletion. Therefore, when protecting a large part of the footage, make sure that the
target storage has sufficient free space, and set lower storage quotas, if necessary.
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25 Sequence

The sequence explorer is an archive playback extension with additional tools for footage analysis. The whole
recorded stream can be split into smaller pieces down to 2 minutes in length; each of these can be played separately
or exported with a single click.

In the Luxriot EVO Monitor upper panel, click the Sequence tab: the current main window will then display the
sequence explorer with empty viewports.

Sequence explorer interface

Interface Overview

Interface elements have the following designations:

Calendar: specify the time period to be analysed by entering date/time boundaries, and also set the
viewport layout

date can be entered manually or selected from calendar view
time can be entered manually or adjusted by mouse wheel (select the value to be changed and
use mouse wheel to increase/decrease it, while keeping the mouse cursor over the field)
minimum time period is 120 seconds
available viewport layouts are: 3x4 (default), 3x5, 4x3, 4x6, 6x4, 5x5 screens

Top panel: <> arrows enable users to browse viewing history within the channel in use; the name of the
channel being used is displayed
Main window: displays video clip sequence with corresponding controls; empty viewports mean that no
footage is available for the time period selected
Bottom panel: contains global sequence controls for the whole currently displayed period (and not the
selected sequence elements) 

the << and >> arrows on the sides enable users to load the previous/next portion of the footage
sequence, with time period equal to the one set in the Calendar
next to the arrows, the date/time boundaries of the current video portion are shown
Play button in the centre of the panel will open current video portion in the Playback mode
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Video button in the centre of the panel brings up the Video export dialog box

Make Sequence

Drag and drop the desired channel from resources onto the main window; the camera name will appear at the top.
Note that the sequencing works with one channel at a time, so if you drag and drop another channel onto the
explorer window, all previous changes will be discarded.

Select sequence timing in the calendar panel on the right and then click the Make sequence button. Video footage
from selected time range will be divided between all viewports, so that all of them will contain video clips of equal
duration. For instance, if the selected time range is 2 hours and a 3x4 layout is set, each viewport will contain a 10-
minute video clip: (2*60)/3*4 = 120/12 = 10 minutes.

Built sequence

From this point onwards, you have several options for creating a new sequence:

enter a new time period on the Calendar panel and click the Make sequence button
select one or multiple sequence elements and click the Make sequence overlay control (see the control
descriptions below)
double-click a single sequence element to split it into a new sequence

If you choose to build a new sequence out of one or multiple sequence elements, their date/time boundaries will be
set as new boundaries, and the video clip in the resulting sequence will be of shorter duration. In this way, any
footage can be split into smaller and smaller chunks down to two minutes, facilitating footage analysis process and
making it easy to find the scene of interest within a larger fragment of footage.

Use the << and >> arrows on the bottom panel to go back and forth along channel timeline. The size of the jumps
back and forth will be equal to the base time period set in the Calendar.

Sequence Controls

Viewport overlay controls are available for each sequence element. Click any piece once to select it; click one screen
once and then click another screen to select a series of fragments. Selection border style will help you control your
actions: a dashed line denotes a single click, solid line appears after the second click. As a result, you will always
know, which selection stage you are on when selecting multiple screens.
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Select one sequence fragment with a single mouse click

Once you have selected one or a set of fragments, overlay controls in the bottom right corner of the selection offer
the following possible actions:

Magnifier button: make a new sequence out of selected fragments; use the History controls <> in the
upper panel to go back
Play button: play selected footage in archive playback mode
Video button: export video from selected time range (no additional Set time range window is displayed)

Multiple regions are selected with two clicks

Timestamps in the top-left and in the top-right-hand corners of each viewport represent time range of the contained
footage fragment. In case multiple screens are selected, the intermediate timestamps are skipped and time frames
for the multi-fragment footage portion are displayed.

Playback

Click the Play button on the bottom panel to open the whole inspected footage portion in the archive playback
mode. The equivalent button on each of the selected sequence fragments will open just that specific fragment for
playback. Playback operation is exactly the same as for usual archive viewing and it is explained at length in
the Archive Playback topic.

Video Export

Click the Video button in the bottom panel to bring up the Video Export dialog box and set your desired time range
for exported footage; channel selection is limited to the one channel open at the time in the sequence explorer.
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Adjust the date/time boundaries during which you want the footage to be exported

The Video button overlay control in the fragmented sequence screens will automatically export video from selected
time range without additional prompts. In either case, the exported video will appear in the Library.

Library notification

Sequence explorer works with the streams based on the time intervals. If you want a more intelligent archive
analysis tool, go to Smart Search to base your search on motion in certain regions.
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26 Smart Search

Along with regular archive playback and sequence exploring, Luxriot EVO Monitor application provides the smart
search feature, which allows you to specify a region of interest and let software search for motion events in the
defined area based on the existing motion detection (MD) metadata. This advanced search option is available for all
Luxriot EVO servers and editions.

There are two types of motion analysis operation: grid and area (frame). Grid type detection is
implemented for software-side motion analysis (both High Performance and High Accuracy modes), while
most devices send their motion detection metadata in the form of areas (frames), this is, the software only
knows if the motion was present in the configured zone, and exact location of the motion in that frame is not
available.

Understandably, precise results of smart search can be only obtained for grid-like detectors. Searching
through an area-type stream by motion region will give you motion events whenever motion has been detected
in the configured detection areas. In order to get better search results with device-side detectors, please adjust
the motion detection zone via device Web interface.

In order to start using smart search, click the corresponding tab on the upper panel of the main Luxriot EVO
Monitor window.

Smart Search option

When you open Smart Search for the first time since Luxriot EVO Monitor application startup, the main viewing
area will be empty. The resources menu on the left will contain all recorded streams, just like in regular playback:
simply drag and drop your desired video stream onto the viewing area in order to start working with it. The panel on
top of the viewing area will have your selected channel and stream name displayed then. The loaded stream will still
be there if you switch to some other tab and then go back to Smart Search.

Smart search with a loaded stream

Search Parameters

The search procedure consists of three main steps: define the region of interest, set the time period and
sensitivity, and analyse the results.
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Once you have selected the stream for analysis, the stream preview will appear in the upper right corner as a static
picture. You can use the buttons below the picture to choose the point in time for the preview: this comes handy in
case the stream comes from a PTZ capable device, or if the underlying device has been moved/replaced. Choosing a
correct scene is crucial for obtaining the correct search results.

Click and drag on the picture to draw a rectangular region of interest. You can mark multiple regions and also
combine them to make them overlap, creating a more complex shape. Press the Clear region button to discard all
areas and start drawing again. If no region is specified, all available motion information will be searched.

Define region of interest

Afterwards, set the search interval using the controls below the picture. You can enter the date manually or use
the calendars to choose a specific day. To manipulate time, click the desired time units and then either enter the
numbers from your keyboard, or use your mouse wheel, while still hovering the mouse cursor over the timestamp.

Next, set the desired threshold for the motion absence by dragging the slider. Threshold range is 5..60 seconds and
it defines how much time should be there between two subsequent motion events for them to be reported as a single
event. For example, if you set the threshold to 5s (minimum), all consecutive motion events with gaps between them
smaller than 5s will be reported as a single search result, and events having more than 5s between them will be
presented as separate results.

When ready, press the Search button to filter the motion events according to your settings. Smart search results
will appear in the central viewing area; if the specified time interval is large, the results may appear not at once but
rather one by one, as the search progresses.

Investigation

Each of the search results will be presented as a preview picture with a timestamp below, the timestamp designating
the beginning of the sought-for motion event. At the same time, all results will be listed on the right-hand side, with
the currently displayed results being highlighted. The list also shows the motion event duration for each of the
results. In the very bottom of the list, the total number of results will be displayed.
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Smart Search in action for a PTZ camera with area type MD

You can change the presentation grid by choosing the desired layout in the drop-down list below the central area:
available layouts range from 3x3 to 6x6 viewports. If there are more results than a single layout can contain, left and
right - |< and >| - arrows will become highlighted, allowing you to browse back and forward. Notice how the
highlighted item set changes as you browse. You can scroll the list and choose any result from the non-highlighted
items; the corresponding portion of results will be then loaded in the viewing area.

Click the event of interest - either a row in the right-hand list or a picture in the central viewing area - to start
working with it: the selected video clip will be looped and played back continuously.

Smart Search result with grid type MD

 The overlay control buttons in the bottom-right-hand of each viewport allow you to perform the following actions
(from left to right):

Play button: go the regular Playback mode to view the search result in a single channel mode
Bookmark button: click to add a bookmark at the beginning of the selected video clip
Video export button: selected video clip will be automatically exported
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For just any video clip in the results you can go to the regular playback mode with a single click of the Play button
overlaying the clip; to go back, simply click the Smart Search tab to get back right where you left off.

When you export a video clip from the search results, it is exported automatically with your pre-defined video export
settings, without the need to confirm the time range. You will still be asked for the file name if you have not chosen
to use pre-defined settings. In order to export longer video clips, either go to the regular Playback mode by choosing
the corresponding tab in the top panel, or select a higher Motion absent duration threshold in the smart search
parameters.
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27 Bookmarks

Luxriot EVO Monitor offers an opportunity to mark any specific moment in time so that it can be easily found in
the Playback mode later. It is possible to add bookmarks from live, instant playback, regular playback and smart
search modes, as well as instant playback mode in the investigation tabs. Bookmarks are displayed and can be
searched through in the regular playback mode.

The bookmark overlay control may be absent in the following cases:

your currently logged user does not have permissions to add bookmarks - in this case, the bookmark
control may be absent for specific channels only
the control had been hidden via application settings (by default, it is enabled)

Also, the bookmark button will be greyed out for orphaned archive tracks in the Playback mode (orphaned
tracks are recordings that have no active channel associated with them).

Bookmark Properties

Bookmarks have multiple severity levels, each one introduced with a different colour on the timeline. The default
level is Critical; this severity level is also displayed for all bookmarks created before installing this version.

Bookmarks in the alarm pane also have a status, which allows you to use them for case management. If you have
sufficient user permissions, you will be able to change the bookmark status when the bookmark is opened for editing
from the Alarm pane or in the search mode in playback.

Bookmarks in Luxriot EVO Monitor playback

Bookmark status can be:

New: the bookmark has been created but has not been commented by anyone (used for case
management)
In progress: once a new bookmark has been modified, its status is automatically changed to In progress
to indicate that the case is being handled
Closed: operators can manually assign this status to indicate that the case is closed
Hidden: also manually assigned

Hidden bookmarks will not appear in search and on the timeline.

Add Bookmarks

You can add bookmarks from almost any viewing mode by clicking the corresponding overlay icon  in the bottom
left corner of the video.
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Select your desired channel by clicking it in live, playback, instant playback or smart search mode.

Among the overlay controls in the bottom-right-hand corner of the channel, locate the bookmark icon  and
click it once. In playback mode, the New bookmark button is located in the bottom-right-corner of the whole
viewing area, near snapshot and video export controls.

Bookmark in playback mode can be found in the bottom-right-hand corner

Bookmark dialog box will appear, offering you to fill in the details. Several details are available in the dialog box:

Channel: displays the currently selected channel name, cannot be changed
Time: bookmark time - inserted automatically but can be adjusted (see details below)
Title: bookmark name, e.g., Motion or Person detected (empty by default), which can be later searched by
Severity: severity level fro your reference, from low to critical (critical is the default one)
Description: user comments - a detailed description of what has happened (empty by default)
Create alarm: the target bookmark will appear in the alarm pane of the subscribers

Bookmark time is automatically inserted using the following logic:

Live mode: the moment of time when you pressed the bookmark button
Instant playback: the currently played moment, the play marker position
Playback: the currently played moment, the play marker position
Smart search: the incident timestamp
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and the timestamp in the bookmark details can be changed at this step by using the calendar or manual insertion
(keyboard) for date and click+mouse wheel or keyboard for time.

While you are adding a bookmark, playback (regular or instant) will proceed in the background without being
paused.

Add new bookmark dialog box

After you have filled in all the desired fields, click Save to add the bookmark at the selected moment in time. Your
newly created bookmark will be available in the bookmark search in Playback mode from now on. Also, all
bookmarks are visible on the timeline: these look as tiny flags, their colour depending on the severity level. You can
hover your mouse cursor over any of the bookmarks to get a tooltip with the bookmark timestamp and title. In order
to see the description, double-click any bookmark on the timeline.

You can change the default bookmark colours via Luxriot EVO Console, under Bookmark policy in the
server settings. This is a system-wide property: for Luxriot EVO Global systems, make sure to open the central
server settings.

After you change the colour related to a certain severity level, all bookmarks with that severity level will start
using the new colour. If the bookmarks are already opened somewhere (e.g., on the timeline of a Luxriot EVO
Monitor), simply refresh the timeline to see the new colour: remove the channel from the view and add it
anew. In instant playback mode, switching to live and back will do the trick.
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Search Bookmarks

All the added bookmarks will be visible in regular playback and also in the instant playback modes, each

bookmark being denoted as a  coloured flag. Hold your mouse cursor over the bookmark to see its name and
exact time; double-click a bookmark to open a detailed description in a separate dialog box.

Bookmarks with different severity in the instant playback mode

In order to search for and view the existing bookmarks added both by you and other users, go to the playback mode
by switching to the Playback tab on the upper panel of Luxriot EVO Monitor. Choose a layout of your preference
either by loading an existing one or by filling the viewports with channels of your choice.

Bookmarks on the timeline in Playback mode

In the upper-right-hand corner, press the Bookmark search button in order to open the bookmark search panel.

Here, you have two options: search by bookmark creation time (i.e., when the bookmark was added, regardless of
its location on the timeline) and/or by actual bookmark timestamp (its position within the timeline). Define the
search parameters:

Time: choose whether you want to search by bookmark time, its creation time, or both at the same time
Date: set desired date and time range for bookmark time, its creation time, or both
Channel: select a channel from the drop-down list (one of those present in the layout)

if you wish to search for bookmarks for all channels present in the layout, choose the "All visible
in layout" option
choose Everywhere to include absent channels into the search

Title: optionally, enter a bookmark title or a part of it (without wildcards) to refine your search results
Description: optionally, enter any part of the bookmark's original description
Severity: choose target severity levels (all included by default)
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Status: filter search results using bookmark's alarm status (by default, hidden bookmarks are excluded
from the search)

When you have entered all the search conditions, press the Search button to obtain the bookmark list.

Bookmark search results

Search results will appear in the list in the bottom of the search panel. Single-clicking a bookmark will auto-locate
it on the timeline, allowing you to see the exact moment, to which the target bookmark has been bound: click the
Play button on the archive playback panel to start playback.

You can also double-click any bookmark either in the list or on the timeline to open it and view its contents in a
separate dialog box. Understandably, you will not be able to change any bookmark details.

Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.
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Bookmark search based on title and severity levels
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28 External Data

Apart from video channels, Luxriot EVO Monitor can present data (textual data) from various sources, for example,
transaction data from POS machines. Other types of data sources may be ANPR readings, barcode data, car
weighing data, etc. The text may come overlaying the video streams or in separate visualizations called data
channels.

In Luxriot EVO Monitor, you can do the following with the data:

view the live data in video overlay or as a data channel
play back the recorded data using instant playback
play back the recorded data using multichannel playback*
export snapshots containing textual data
export video clips containing textual data with or without video
search the recorded textual data
run more complicated queries across available databases

Based on the server side configuration, your Luxriot EVO Monitor instance may also produce events based on
keywords or key values received from the data sources. For example, in a store, you may want to have the video
popup on a bigger screen when the customer's purchase total exceeds 100$.

*If you have data channels for dedicated data view, arrange and save layouts that contain both data and video
channels so that you can view the related information together (e.g., in a store there is a camera overlooking three
self-checkouts.

Live Data Streaming

Depending on the system configuration, you may encounter two types of data presentation.

1. Video overlay

Textual data from the associated external data source will appear embedded with the live video stream. This
happens automatically and you do not have to do anything else in Luxriot EVO Monitor to enable the video overlay.
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Textual data overlaying video stream: text position, size, and color are adjustable on the server side

2. Data channels

Data channels are data visualizations without an underlying video stream. You can find them in the resources panel,
under Channels, with a POS-like icon.

Live data channels present the incoming data as a cheque, with page breaks between transactions.

A data channel in live view

With both types, you can perform the usual channel-related actions using the overlay controls: add bookmarks, save
snapshots, switch to the instant playback and other modes, etc.

Instant Playback with External Data

Both data channels and video streams containing a data layer are available in the instant playback mode.

The external data is marked in the archive by a thick dark green ribbon. It is non-continuous so you can see which
periods do contain data (similarly to motion information).
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Instant playback for a channel containing both video and external textual data

Use the overlay control buttons in the bottom right corner to export snapshots and video clips, add bookmarks,
or switch to the regular playback mode. 

Video and Snapshot Export with External Data

You can save snapshots from any mode by clicking the camera overlay  button in the bottom right corner of
the viewport. The snapshot will be saved using the default settings, or, if set so, an additional window with the
settings will pop up, allowing you to choose them every time.

For the textual data to be included with the snapshot, do not forget to enable the Include external data option
in the export settings.

Enable this option for correct data export with snapshots and video clips

You can export external data snapshots in 4 modes:

save images from video channels with data overlay
save images from data channels
save PDF reports from video channels with data overlay
save PDFs from data channels
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For video export, use the play  overlay button in playback modes. Use video export settings that support
external data overlay - those with compression instead of original format. For example, you might want to use
AVI+JPEG or MKV+VP8.

Search Data Sources

If at least one of the connected servers has data sources attached to its channels, an additional tab will appear on the
top panel, named Data Sources. The search logic here is as follows:

specify the target channel(s) by clicking the + next to the channel name in the Resources pane on the left;
use the - next to the channel to deselect and exclude it from the search
enter you search criteria and time range in the panel on the right side: the date can be either entered
manually from the keyboard or selected using the calendar control
click the Search button to view the results

Simple search query in the dedicated Data Sources tab

Please note that, depending on the selected time range and number of channels, the search may take some time; the
results will be listed in the central viewing area after they have been found. Do not press the Search button
repeatedly: this will re-initiate the search process.

Double-click any specific search result and it will be opened in the central viewing area in the instant playback
mode.

Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.

Data Playback

In the multichannel Playback tab:

video channels with data overlay are available for regular playback,
data channels can be brought onto the viewing area and played back as well,
you are welcome to create layouts in order to make the data channels appear together with the related
cameras,
and there is a special mode for advanced search across data channels.

When you play back data channels, they looks the same as in the live view, with one exception: the current
information is highlighted with a box around the text.

Database Search

When in Playback tab, click the Databases button in the upper right corner to bring up the advanced query panel.
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If the Databases button does not appear, it means there are no data channels configured on the connected
server(s) (or configured incorrectly).

The database search mode allows you to create, save, and load advanced (complicated) textual queries. In this
way, you can request specific information from the existing databases and view it combined with the recorded video
streams. Example: show all POS transactions for the past 2 weeks where cashier Peter Purrker sold cat food for more
than 100$.

 Database search mode in the Playback tab

Use the search panel on the right-hand side to form a query:

1. Choose the database from the drop-down list
2. Click the Source field and choose the desired data channels or visual groups containing data channels
3. Set the target time interval (an exact time range or a relative option, like "the last 10 days")
4. Add query parameters (see below)
5. Choose sorting (ascending/descending)
6. Choose target detalization (whether you want to see transactions or transaction items in the result list)
7. Click Search
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Choose all relevant data sources one by one or by visual groups 

The result list will appear in the table in the bottom part of the panel. Click any result to display it in the viewing
area. If the target data channel is linked with video stream(s), they will appear together.

Click the Export button below to save the list of results into an XLS, PDF, or CSV file.

Create Database Queries

In order to create queries, add conditions in the right-hand side panel:

in each database, there are two tables, their names displayed on the left
you can add conditions and condition groups for each of two tables
if there is more than one condition inside the group (on the same level), you can choose whether to apply
the AND or OR logic to them

Use the recycle bin button on the right to remove conditions.

Query example: display all entries where operator named Peter sold cat-related products with the product
subtotal over 100$

Query example: show all entries where either Peter or Mary sold bread

Query Results
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When you click Search, a query with the given conditions is sent to the database, and you will see the results in the
lower part of the database search panel. If there are no results for your criteria, you will see the corresponding error
message. Double-click any search result to open the corresponding transaction.

Your conditions will be highlighted in the search results - both in the list and in the transaction window.

Results for the database query "Peter or Sherita sold a product containing potato during the last 12 days" with a
full transaction view

Note that, regardless of the Request target setting, you will always see the full transaction in the popup window. The
Request target setting affects the search results:

if the main (first) table is selected, each result will represent the target transaction
if the detail (second) table is selected, each result row will match the transaction row (item)

Thus, if your query only contains conditions on the second table and the request target is set to the first table, there
may be no highlights in the list of results. You will need to double-click the transaction items to see the whole
transaction with all details.

Save and Load Queries

The creation of complex queries will take some time, so you may want to save them for later reuse.

Once you have created the desired query, scroll to the top of the search panel: you will see the query buttons in the
top right corner of the panel. Use the Save button to save the query:

choose the New Database Query option to create a new entry, or
select an older item from the drop-down list to overwrite.

Use the down arrow button next to the query name to see the list of available queries. If you have just started
working with this feature and have no saved queries, the query name will be New query. If you are working with a
previously saved query, you will have an option in the drop-down list to create a New query (all current changes will
be discarded). When there are previously saved queries, these will appear in the drop-down list as well, allowing you
to load them by clicking the query name.
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Query controls in the top right corner of the search panel: current query name with a drop-down list with load
options, Reset, and Save

If you have modified a pre-saved query and you wish to discard the changes, use the Reset button.

To remove any of the previously created queries, click the down arrow next to the query name > click the three dots
... button next to the query name > click Remove.

The queries are saved locally and can be transferred to other Luxriot EVO Monitor workstations using the
import/export of the application settings (main menu Tools > Import/Export settings). Use the Local
resources category for database queries.
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29 Video Analytics Events

Playback section has a special investigation mode that allows browsing the archive based on the video analytics
events. These events may come from: 

server-side video contents analysis (VA) engine,
server-side VA engine,
server-side Open VCA engine,
and camera-side analytics (onboard/edge VCA).

Events from the server side must be pre-configured to be recorded together with the video stream. These
are displayed in Luxriot EVO Monitor and can be investigated and also exported to an external file in the comma-
separated format.

VCA event data are available for server-side analytics and also for camera-side VCA in case metadata are
supported for that particular camera brand. For the exact manufacturer list with VCA metadata support,
please contact Luxriot representative.

In playback, VA and VCA metadata are represented by a thick white stripe over the footage. This means, these events
can be searched for in the Playback mode. To access the VA investigation panel, go to playback mode in Luxriot EVO
Monitor and click the VCA button in the top right corner.

Earlier Luxriot EVO versions had a continuous timeline stripe for VA metadata. Starting from v.1.20.0,
metadata are displayed similarly to motion, with the timeline overlay only present during periods with
analytics detections.

Video analytics event investigation in the playback mode

The appeared panel will allow you to specify the search criteria, which are:

Source: a channel currently present in the layout that has VCA enabled
Search interval: time range to look for the events in
Search for: VCA/VA item to search for, can be an object, a counter or an event

Object: all entries containing object appearance according to the VCA/VA object classification
Counter: all moments where any counter value was changed
Event: all entries from triggered VCA rules

Class name: VCA or VA class name (full or partial) according to the VCA/VA internal object classification
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For the built-in video analytics engine, you can search by VA objects, events, rule names (full or partial), or
zones.

When ready, press Search to get the results based on your refinements. Click any result in the list to jump to it in
playback, then press the play button below the timeline to start viewing the footage.

Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path.
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30 Reports

Reporting mode in the corresponding Luxriot EVO Monitor tab provides reporting functionality based on the
previously collected data. There are two types of reports: heatmaps, based on motion information, and charts,
which use data from the software and VCA counters. You can view the reports in the application and then export the
results.

Heatmaps

Heatmap type reports represent motion density in the picture, thus highlighting the regions where the most
motion has happened during the selected time range. Heatmaps are generated based on the motion detector
(MD) data, therefore, motion detection must be enabled beforehand for the target channel via Luxriot EVO Console
application.

Here are the requirements and some recommendations regarding heatmap reports:

target channel must have grid type MD enabled
motion information must be recorded with the video (represented by cyan colour on the timeline in
playback mode)
for PTZ cameras, make sure to select a static interval (during which the camera was not panned, tilted or
zoomed), otherwise the map will be inaccurate
if you are using server-side MD and your video stream has camera-side timestamp overlay, make sure to
add it to MD exclusions via Luxriot EVO Console (otherwise, the changing digits will trigger false motion
and your heatmap will be biased)

Heatmaps use data from grid type motion detectors. Grid is guaranteed for software-side MD, and also for
a few device-side detectors. Heatmap detalization depends on the MD grid size: the smaller the grid cell, the
finer the map will be. Hardcoded internal grid size for the heatmaps is 128x128.

Most of the device-side MD do not support grid mode: if this type of MD is enabled in the device properties in
Luxriot EVO Console, you will get an "unsupported MD configuration" error and the heatmap will not be
generated.

To start, drag and drop a channel from the resources panel on the left. The channel name will appear on top of the
viewing area. If, for some reason, there is no motion data, or it is incompatible (frame type instead of grid), you will
get a corresponding error.

Next, select the target time interval, days and hours to be analysed:

Heatmap interval: defines the total report period
Filters: define the target range of time and exact days to be taken into account

For example, you can select one month as the time interval, and then only select weekdays (Mon-Fri), from 8AM to
8PM.

Use the Set time, +1h and -1h buttons below the channel preview to select the image to be used for the heatmap
overlay. Particularly, this makes sense for PTZ or zoom-only cameras, where the snapshot time matters. Also, you
might want to use this option to find a timestamp where lighting conditions are optimal, or there are no unwanted
objects in the scene. Use the Reset filters button below the settings in the right-hand panel to restore the default
filters (all days 24/7).

When ready, hit the Generate heatmap button: depending on the selected interval, this may take some time, and
you will see the generation progress displayed as percentage.
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Heatmap report example: red=max, blue=min 

As soon as the analysis is complete, the heatmap will appear in the viewing area.

Colours on the heatmap range from blue to red, blue representing the "coldest" places (where the minimum amount
of motion was detected for the given period), and red stands for the "hottest" places (the maximum amount of
motion). The rest values will be in between (blue>>violet>>red). Regions without any colour overlay are those
without any motion detected for the specified period (including, but not limited to, non-detection zones).

Click the Export heatmap... button below the image to save the snapshot with the heatmap overlay as a JPEG
file. An additional dialog box will pop up, allowing you to choose the destination folder and the file name.

When the heatmap is generated, only the top motion areas are taken into account (and those with the least
amount of motion are dropped). This means, if some regions are too "hot", you may see other areas not
highlighted at all, as they do not have enough motion events compared to the "hottest" ones. In other words, if
you see that some area in the heatmap is not coloured, it does not mean it had no motion at all; rather, it had
none or almost none during the selected period compared to the "hottest" areas.

To avoid such situations, make sure to configure MD exclusion zones for objects like bushes & trees, as well as
the camera-side timestamp.

Charts

Luxriot EVO Monitor application provides an opportunity to build graphs based on the counter data, which has
been recorded with the video stream(s). Depending on the collected information context, these reports can be used,
for example, to estimate the average number of customers during specific hours, compare the number of passing
cars to the number of trucks etc. Counter information is collected from Luxriot EVO Open VCA video analytics,
camera-side VCA (for certain manufacturers) and software counters. Software counters, in their turn, can be
based on any events, including software-side video analytics (VA).

For the exact list of supported camera-side VCA counters, kindly contact our support engineers at
support@luxriot.com.

There are three chart types: bar, line and pie diagram. Regardless of the chosen type, all reports are based on the
counters and have configurable report interval and days and times of interest. Counter values are compared for the
given period and with the specified scale, and the results are then reflected in the chart of the selected type. Any
report can be also exported as PDF.
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Bar diagram report example

In your Luxriot EVO Monitor application, switch to the Reports tab: this functionality will be available when at least
one of the connected servers has Open VCA operating or software counters configured for at least one of its
channels, and the used user account has sufficient privileges to access the recorded counter metadata. If you have
just added a new counter, please wait several minutes for the data to be collected and flushed into the database
before it becomes available.

Automatic report generation is also available for Luxriot EVO and can be configured via the Luxriot EVO
Console application.

You do not need to set VCA channels manually: all the available counters are listed automatically in the right-hand
panel, under Counters, with the channel title displayed in brackets next to the counter name.

Specify the reporting criteria in the right-hand panel, which is divided into several sections.

Counters:

Select desired one or more counters to be included in the report (none are selected by default)
All the counters present in the system are listed, with their source channels specified in brackets, if
relevant

Report time interval:        

Choose the start and end date and time for the target report

Report filters:                    

Week days: select days of the week that you want to be included in the report (e.g., ignore weekends)
(all days are selected by default, marked blue)
Day time interval: choose the target audit interval to be analysed for each of the selected days   

Report visualisation settings:

Select the diagram type by toggling the icons: from left to right, these are bar, line and pie type; the
currently selected mode is marked blue
Aggregation: specify the scale factor for the target diagram - results can be presented by months,
weeks, days, hours or minutes (also, the data can be aggregated by counters if the selected chart type is pie
diagram)
The counter value* setting lets you choose, what value is taken for each report time interval on the X
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axis (day etc.):
Absolute: actual counter value at the end of the interval
Relative: difference compared to the end of the previous interval
Average: average value on the given interval
Minimum: minimal value during the given interval
Maximum: maximal value during the given interval

Choose whether you want each counter to be represented separately or all counters are to be added up

*Please see below for more details on how different counter values are calculated.

Report interval defines the whole period to be reflected in the report. Report filters specify which
exact time period should be analysed for each of the selected days of the time window specified as the report
time interval.

For example, if you wish to examine customer flow during working hours for the past two months, you need to
set:

two months' period in the Report interval section
only mark working days in the Report filters section (unmark the weekend as all the days are pre-
selected by default)
set the time interval under Time filter in the Report filters section to your target working hours

Choose the diagram type by toggling the icons in the bottom of the right-hand panel in the Report
visualisation section: from left to right, these are bar, line and pie type. The currently selected mode is
marked blue.

When ready, hit the Make report button in the bottom of the right-hand panel to display the report diagram based
on your selected criteria. Note the total time required for the chart construction may demand several minutes. You
will see the Loading... status in the right-hand panel indicating that reporting is in progress. You can modify the
report criteria and restart the reporting process without having to wait until the current diagram is finished.
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Pie diagram report example

On each diagram, the horizontal axis (X) represents time in the specified scale, and the vertical axis (Y) reflects
counter values. The counter values for each time interval are calculated based on the selected setting and can reflect
absolute, relative, average, minimum or maximum counter value for the given interval. In the pie diagram type,
each sector can represent either a time interval or a counter, depending on the aggregation setting parameter.

Each chart also contains a legend that provides information about colours used in the diagram:

if you have selected to analyse every counter separately, each counter will be represented with its own
colour and the legend will reflect counter titles
if you have chosen to sum the counter values:

bar diagram will have just one column for each interval, every column consisting of specified
counters and its total height reflecting the total
line diagram will contain graphs for each individual counter and the total

pie chart will reflect the counter sum for each time interval if aggregation by time intervals is chosen, so
the legend will contain timestamps; if aggregation by counters is selected, the pie will reflect the
proportion of the counter values for the whole selected audit interval

Any report can be also saved in PDF format. To do so, click the Export report button above the diagram and
specify the file name and path for the report to be exported to in the dialog box that appears; then, click the Export
report button in the dialog box to create the file.

Math Behind Counters

Different counter value settings will produce different results, so you need to understand which value to select in
order to get the appropriate result. Below, you will find some details on how these values are calculated inside
Luxriot EVO.

For each and every selected interval, five counter values are calculated: absolute, relative, min/max, and
average. The minimal internal interval is equal to 1 (one) minute; no matter how the counter value changes
during that minute, these five values are recorded into the database. For longer periods (hours, days, etc), these
values are calculated using the intermediate results.

In the snapshot below, there is an example of how the counter value might change during one minute, and what
values are calculated based on these changes.

An example of counter changes within report interval with corresponding peak values

For correct report results, it is also essential to keep in mind whether the counter in question is increment-only, or if
it is both incremented and decremented based on some events.
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Counter value options:

1. Absolute

Absolute counter value is its exact value at the end of the measurement period. E.g., If the interval is 1h, the
absolute counter value is equal to the absolute counter value for the last minute of that hour.

Usage examples:

increment-only: estimate the total people flow, e.g., incoming customers
increment/decrement: current number of people in the zone/building

2. Minimum and maximum

Here, Luxriot EVO simply takes the min and max value from the aggregation interval. For longer intervals, min/max
are selected from the list of min/max of smaller periods (regular min/max function).

Note that min/max has nothing to do with absolute value: the counter value may peak inside the aggregation period
with the total change (absolute value) being zero. The latter, of course, is only possible for the counters that are both
incremented and decremented over time. For increment-only counters, max value will be equal to absolute value.

3/4. Relative

Relative counter value is the sum of all relative changes for the given period, or, even simpler, the difference between
the current absolute value and the previous one. Relative value shows how much the counter value has changed for
the given period compared to the previous one.

5. Average

Average counter value is counted as weighted arithmetic mean, with the duration serving as weight.

Simple arithmetic mean would not be as useful as it does not take into account the value duration.

Consider the two examples in the snapshot below: two counters have the same absolute and relative values for the
given period. Their arithmetic mean would be very similar (25 vs 26.6), while it is obvious that the first (green)
counter value stayed higher for a longer period, and this should be taken into account.

Example of two counters with the same absolute values and different average

Usage example: average number of customers in the store per hour, average check total for estimating effectiveness.
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31 Access Control

If your Luxriot EVO server employs a connection with a third-party access control system, it is possible to view
events and other data from the integrated module in the Luxriot EVO Monitor application.

Here is an example of how this can be done based on the connection to Doors .NET, which is possible thanks to the
integration of Luxriot EVO with Keri Systems.

Access Control

To start working with the access control data, switch to the Access Control tab in your Luxriot EVO Monitor
application.

Access control tab

There are three sections available here:

Events: the list of door events
Doors: door list with statuses
Cardholders: the list of cardholders

Click any event to view its details and associated recorded video (if a channel has been bound to the door in Luxriot
EVO Console). Events can be filtered based on time, door name, cardholder and/or event name (or a part of it).
Playback will appear on the right side as instant playback, with all usual controls, when an event is selected.

Click any door in the list to view its live status and associated live video (if configured). Every door will also have
three buttons to let you lock, unlock or temporarily unlock it. The View door events button will take you to the
Events section, with the event list filtered and only displaying entries related to the selected door for the last day.

In the Cardholders section, you will have the list of cardholders with pictures, if there are any. Use the Refresh
button in the bottom to reload the list. The View cardholder events button on the right will take you to the Events
section, similarly to door events: the event list will only display events for the target cardholder for the 24 hours.

Maps

Apart from the dedicated Access Control sections in Luxriot EVO Console and Luxriot EVO Monitor applications, it
is also possible to place door markers onto maps – either regular ones or geo maps. Markers on the map reflect door
open state and lock state. If such maps have been configured on the server, they will be available in the
corresponding section on the left, in the Resources panel.
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A map with door markers

In the Luxriot EVO Monitor application, place your map into one of the viewports either by dragging and dropping it
or by pressing the … button next to the map title and choosing the destination display.

Right-click a door marker to see door related actions

Each door marker will reflect status according to the settings defined in the map configuration. Also, every door
marker can be left-clicked to bring up a drop-down menu with associated door actions, these being: lock the
door, unlock the door and temporarily unlock the door. When triggered, these actions will be displayed in the Events
list in the Access Control section.  
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32 Video & Snapshot Export

Video clips, frame sequences, multichannel layouts and individual pictures can be exported in order to be viewed
later without Luxriot software.

Snapshot Export

A snapshot of an individual channel can be taken at any time from live view, sequence explorer, instant playback and

regular playback modes. To save a snapshot, click the Snapshot  button in the overlay controls or bottom panel
controls. If you have pre-defined the snapshot export settings in the application settings, the frame will be saved
immediately; otherwise, a dialog box will pop up, prompting you to specify the save parameters. Please check the
topic on application settings for detailed description of each parameter.

If the picture was dewarped or zoomed in using DPTZ, the snapshot will contain the target region.

If the channel has video analytics configured, all currently displayed visual elements will be exported with the
snapshot. To change VA element visibility in Luxriot EVO Monitor, go to the Application settings and change the
VCA settings in the Video overlays tab. All elements that have the Always On and On if selected settings will be
embedded into the snapshot, while elements that have the Always off setting will not be exported.

In playback mode, it is possible to export a snapshot that will consist of all channels present in the current layout. To

do this, use the Multichannel Snapshot  button in the right side of the bottom panel. The resolution of the
combined frame is 3840x2160px.

The frames will be saved with your pre-defined frame export settings, if this option is enabled in the Application
settings; otherwise, you will be prompted to specify the file name and quality preference. After you have clicked the
snapshot or multichannel snapshot button, the frame will be automatically saved in JPG format and will appear in
the Library section of Luxriot EVO Monitor.
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Save snapshot as PDF: an extra dialog box will pop up, allowing you to enter an additional description

Snapshots can be also saved as PDF reports. For this, enable the corresponding setting in the snapshot export
profile. When the report is ready, you will see it in the Library section.

Video Export

Video export settings can be pre-defined in the Luxriot EVO Monitor Application settings. These include: file name,
output format, compression and resolution preferences, as well as subtitle settings. Some of the settings, when
selected, allow additional features like motion blur.

If you wish to embed the external textual data with the video or use motion blur, use MKV export format
with VP8 compression. MKV format also exclusively allows to export video in time lapse mode.

Time presentation settings do not affect video clip export. When you export a video clip from a remote server,
which is in a different time zone, and add timestamps in subtitles, your local time will be used.
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You can choose to use the pre-defined settings always; otherwise, you will need to confirm or adjust the export
settings every time you export a video clip from anywhere. All the exported fragments will be displayed in
the Library immediately.

Video can be exported automatically (without additional time range prompt) by clicking the Video Export 
 button in the viewport overlay controls:

from Sequence Explorer, by selecting a range of at least two video fragments: selected clips will be
exported
from the Instant Playback mode: the most recent currently loaded footage will be exported at once (last 5
minutes, by default).
from the Smart Search mode, by selecting the desired search result: selected fragment will be exported

A video export dialog box with additional settings can be launched in the following ways:

from Playback mode, by clicking the Video Export button in the bottom right panel (the channel choice is
limited to those that are currently displayed plus multichannel export)
from Sequence mode, by clicking the Video Export button in the centre on the bottom panel (channel
choice is limited to channels currently being viewed)

Video export dialog box

When exporting from Playback with advanced options, you will have an opportunity to choose the stream to be
exported (from the channels currently present in the layout) or, alternatively, choose to export the clip with all the
displayed streams (multichannel export); also, you can combine any video stream with any audio stream (also
coming from one of the displayed channels).

In playback mode, it is possible to export a video clip that will consist of all channels present in the current layout.
The maximum resolution of the combined frame is set up via application settings (main menu Edit > Settings >
Video export). Default limitation is 2MP (1080p).

In Sequence mode, stream selection is reduced to the sequenced one and you can choose whether or not you wish to
export the associated audio stream, too. In both modes, you can specify the date and time range for the exported
video clip.

All exported video data are split automatically into files of ~1.8GB size to guarantee that the files are played
correctly. The file size and time required for export depends on the selected file output format, compression,
resolution and subtitle presence.
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Select your desired date and time boundaries for the export of the footage: dates can be picked from the drop-down
calendars, times can be adjusted by clicking hours/minutes/seconds and then scrolling up/down with mouse wheel.
When you are ready, click the Export button; the video file will be saved with your pre-defined video export settings,
if enabled; otherwise, you will be prompted to specify the stream properties and export directory.

Motion Blur

Exporting video clips with MKV+VP8 settings gives you an extra option to apply privacy masking to the video.
The video is retrospectively scanned for motion (software-side MD is applied) and the selected regions are blurred,
thus hiding whatever is behind the motion. First, enable the feature in the video export settings, and then an
additional dialog box will pop up every time you export a video clip.

To enable privacy masking, choose the following settings for video export:

Video output file type: MKV
Video compression: VP8
Motion blur: enabled (checkbox)

Video export settings for enabling motion blur

Next time you export a video clip, you will be asked if you wish to proceed with motion blur. Click Yes to open the
dialog box and adjust blur settings, or click No to export this video clip without any masking.
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On the right side, choose the settings you find appropriate:

Grid size: motion grid dimensions for both region selection and motion processing, can be 16x16, 32x32,
or 64x64 (larger grid size corresponds to smaller grid elements)
Intensity: blur level, ranging from very low (minimum blurring) to very high (heavy blurring)
Motion sensitivity: detector intolerance to changes, ranging from very low (small fluctuations will be
ignored) to very high (smallest changes will trigger MD)

Then, draw detection areas over the preview image. Simply select the area type and mark the desired grid cells
according to the required masking levels:

no blur (transparent, no colour)
blur always, regardless of motion presentce/absence (red area)
motion blur with specified sensitivity (blue area)

By default, when the blur dialog box is opened, the whole image is marked blue, which stands for motion blur
only. Draw over with a different colour to change the detection type.

Privacy masking using motion blur
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When ready, click Apply and export: your video clip will be then exported with the blurring effect. Depending on the
selected blur settings and video clip size, this make take some time: the selected part of the video stream will
be analysed for motion, meaning that the existing motion data, if present, are ignored. This also means that privacy
masking can be applied to any video stream, even if there are no motion data present in the archive.

If you wish to discard blurring but still want the video clip to be exported, select Skip blurring: the video will be then
exported immediately, without privacy masking. Finally, if you have changed your mind and no longer wish to
export the video, click Cancel export to simply close the dialog box.
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33 Alarms and Notifications

The Luxriot EVO Monitor application has several ways of displaying different notifications received from the
servers. Depending on the alert type and/or configuration, they may appear in the live notification pane (channel
overlay), in the Alarm pane, in the dedicated Alerts tab, or as popup dialog boxes.

If you want to send alerts to Luxriot EVO Monitor from Luxriot EVO servers, use the Event & Action
Configurator in Luxriot EVO Console. Use the Send event to client and Create bookmark action types.

Notification Panel
Each channel in the live view has an overlay notification panel. It is hidden by default and can be toggled by
clicking the corresponding  overlay element in the bottom-right-hand corner of the viewport. Depending on
your application settings, this overlay control may be disabled, shown always, or only shown when the viewport is
selected (default setting).

Notification panel overlaying live video

This pane displays several types of messages related to the target channel:

streaming errors (RTSP, wrong password, etc.)
text notifications from E&A (pre-configured)
results from external services (e.g., recognized license plates with thumbnails)
other custom event messages (pro-configured on the server side via Luxriot EVO Console)

Messages related to the video archive (e.g., recognition results) are interactive meaning that you can double-click
them to go to that moment in the archive. 

For this panel, there are two configurable settings in the application settings: font size and an option to display
thumbnails (tiny images) for the external service results. You can also adjust the panel appearance for each
viewport individually; for this, long press your left mouse button on the panel and then click the Edit button (with
the pencil). The process is described in more details in the Overlay section of this document.

Alarm Pane
In the live view, it is possible to bring up an additional panel that will contain alarms generated by connected
servers. These alarms are, essentially, bookmarks, therefore they possess all features of bookmarks (severity, color,
comments) and can be also searched for via playback.

The alarm pane may be hidden by default. To enable it, go to the main menu > Edit > Settings > Usability >
Show alarm pane.
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Administrators can disable the alarm pane completely via Luxriot EVO Monitor administration tool.

You can interact with the alarm pane as follows:

new alarms pop up in the pane (newest on top) according to the selected filters
click any alarm to handle it
scroll up and down the list to view the rest of alarms (if new ones arrive during this time, the red
UPDATES sign will appear on top, indicating that there are new entries - click it to scroll to the very top)
create and manage filter tabs with different settings to group alarms (e.g., by channel and/or by type)
right-click any alarm to see available actions and quick filters
click the multiselect button (left from the Search field) to select multiple alarms and do a bulk action:

change alarm severity
change alarm status

If you change the alarm status to Hidden, and your current filter does not include the hidden alarms, these alarms
will disappear from the list after you click Refresh under filter settings.

Multiple selection button

The alarm pane state, including tabs, is preserved in the Luxriot EVO Monitor application settings, so your created
tabs will not disappear until you close them manually or uninstall the application.

Alarm pane on the right side of the application window 

Click any alarm to view the related event: a floating window will appear. To close the popup window, click
anywhere on it. Here, you can:

view the snapshot from the related channel
use the overlay buttons on the snapshot (bottom right corner) to pop up the live view or instant
playback in the main viewing area
change alarm severity: click the ... (three dots) button next to the severity level and choose a new one
from the list
change alarm status (New/In progress/Closed/Hidden) (all incoming alarms have the NEW status)
add comments: type in the text box and press Add comment, or use CTRL+Enter (adding a new
comment automatically changes alarm status to IN PROGRESS)
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 If other operators change the alarm status or append comments, it will be reflected in real time, and you do not
need to refresh anything.

Floating window with alarm (bookmark) properties

You can also drag and drop any alarm onto a viewport to open it in the instant playback mode.

Quick Search

The alarm pane has a quick search field for filtering the current alarm list without modifying the filter set. Simply
start typing the alarm status or description to filter the list; clear the search field to revert to the full list. The search
includes all textual descriptions and comments, as well as alarm status (new/closed/in progress).

Search syntax:

enter a word or a part of the word to be searched for (case-insensitive)
Allow use "+" for required words.
"#tag1+#tag2" must match when both tags exists
"#tag1 #tag2" must match when any tag exists
"#tag1+#tag2 #tag3+#tag4" must match when both #tag1 and #tag2 exists or when both #tag3 and #tag4
exists
Use bookmarks title, description and comments when searching text (currently only title is used)

Alarm Filters

The alarm pane has permanent filters for the alarms. You can create several tabs, each one having its own filter
set, and switch between them.

Click the Filter button to open the filter list, and click it again to close the filters.

Filters: use filtering if you only want to receive a certain class of alarms. You can create additional tabs with
different filters, and also lock/unlock these tabs to prevent them from accidental deletion.
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Alarm pane filter

Alarm pane with two locked filter tabs

 

The alarm filter has the following options:

Text: textual search across alarm status and description
Severity: choose relevant bookmark severity level(s) (blue=selected)
Status: choose all that apply
Channels and channel groups: all by default

Click the Any field under Channels and groups to bring up an additional dialog box: it will let you choose alarm
sources. You can choose all desired channels, visual groups, or whole servers. Use the Reset selection button
to revert the changes (no channel filtering will be used). When done selecting channels, click Save to go back to the
filter configuration.

Click Apply to filter the alarms according to the selected criteria, then click the Filter button again to hide the filter
list. The alarm output will now be limited to your criteria.

If you wish to remove any filtering and see all alarms again, click the Filter button > Reset > Apply.
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Alerts Tab
The Alerts section of Luxriot EVO Monitor acts like a temporary client audit log that is purged after the app is
closed. It features:

automatic server notifications: logon/logout, channel events etc.
pre-configured server notifications (via E&A)
local client events - layout popup, user button triggered, etc.
miscellaneous errors that arise during operation and are related to the current client instance: stream
errors, server connectivity issues, device connection errors and others.

These messages have three severity levels: info, warning, and critical. Critical level is assigned to the most
important messages like connection failures. Notifications from Luxriot EVO E&A (pre-configured notifications) are
displayed as warnings. Regular notifications are informative and are therefore marked as Info. For example, if
archive is corrupt or has been altered with third-party tools, a critical warning will appear in the Alerts tab.
Whenever there are new alerts, a red counter will appear next to the tab name.

Alerts section

 Use the Search field in the upper-right-hand corner to filter alert messages.

Alerts section with filtered messages

Along with type and source, alert message and time are shown for each entry. If the message is too long to be
displayed in full, hover the mouse cursor over it to read full message text.

Popup Notifications
This kind of alert only appears when triggered from Luxriot EVO Events & Actions (action type: send event to client
+ display a warning message box setting). The popup dialog box stays on top and prevents user from accessing any
controls in the background until closed. When pre-configuring the action in Luxriot EVO Console, you can also
specify a timeout in seconds, after which the message box will disappear automatically.
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Popup notifications in Luxriot EVO Monitor

If there are several notifications in the queue, they will appear on top of each other (oldest first), and you will have
an option to close them all at once by clicking the Close All button.
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34 Library Section

The library displays all the exported video files and snapshots that are available, as well as ongoing export jobs.
Essentially, the library section merely displays the contents of the directory, which has been set in the application
settings as target folder for the exported files. The file list is refreshed upon Luxriot EVO Monitor startup and every
five minutes after that, so if some files are removed manually via Windows Explorer, it will take up to five minutes
to synchronize the changes.

Files that are still being exported (current export jobs) will be shown in grey, with the current export percentage
shown in the Status field. After that, the entries stay in the list with related details and export status.

Library section

Click the Open button on the upper panel or just double-click any file to open it with your OS default media player:
exported video files and images can be opened by standard media players (Windows Media Player, VLC etc.). This
normally works for AVI and JPG file formats; for other video formats (MKV, MP4), you may require the Portable
Player tool.

Use the Show in Windows Explorer button to display the export directory containing the selected file.

To remove files both from the library and from the hard disk, select one of multiple files and click Delete button on
the upper panel. Use the Search field in the upper panel to filter the items.

File Export to External Media

Click any file or files and hit the Copy to... button on the upper panel if you want to copy the target file(s) elsewhere,
i.e., on a USB drive, a CD/DVD etc. File copy dialog box will appear; click Browse and select your desired location.

Choose destination
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If you choose a regular disk or a USB drive as a destination, your file(s) will be simply copied into that directory.
Should you want to burn the file(s) to a CD/DVD, additional Windows dialog box will appear.

Choose USB flash drive type

In this dialog box, select the desired option. Insert a CD/DVD into your CD/DVD-ROM and click Next. Windows will
format the media, if necessary (if unformatted). Note that, whichever option you choose, the burning process will be
handled by Windows, not by own Luxriot EVO means.

You can either use a blank CD/DVD or append files multiple times to the same CD/DVD if you use the first -
USB flash drive - method, as if the disk were a USB drive.

Windows is preparing media

Next, you can select Watermark Validator and/or Portable Player to be added to the target location together with the
file(s).

Watermark validator is a tiny tool that will allow you to check file watermark and confirm they are integral and
intact. Note that if you are copying file(s) repeatedly to the same location and watermark Validator already exists
there, it will not be added twice. Portable player is a standalone media player designed to play back media files
created by Luxriot EVO.
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Review your preferences before copying

When ready, hit Copy to transfer the files to the specified location. If you have chosen to burn a CD/DVD, Windows
will handle the burning process.

Copy progress

Copy progress will be reflected in the library section. When the process is finished, you will be able to:

use the Show in Windows Explorer button un the upper panel to open file destination
open and play the file(s) using Luxriot EVO portable player
open and play the file(s) using standard Windows or third-party video player on the same or on a different
computer
run Watermark Validator and check file integrity by dragging and dropping them into the validator
window
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35 External Services

External services in Luxriot EVO are, primarily, LPR (License Plate Recognition) and FR (Face Recognition)
modules, as well as any system-specific third-party modules that have been integrated with Luxriot EVO via HTTP
API. If additional external services have been enabled and set up for your server(s), these will allow you to receive
live event streams for the corresponding channels and also to investigate the recorded event data together with the
video streams.

Live

If recognition is running for a specific channel, you can see the recognition results by opening the Notification Pane
for each individual channel. The pane can be toggled using the viewport overlay controls, and its availability can be
set up via Application Settings.

Live view with LPR recognition

The list of the live results is cleared when you close the Luxriot EVO Monitor application meaning that each time
Luxriot EVO Monitor starts with an empty notification pane and it gets filled as the recognition results arrive. The
notification state (ON/OFF) is saved with the layout, local or shared.

If your target channel is recorded, you can double-click any entry to see the moment of the recognition played
back automatically in the same viewport using the instant playback. The recording status is showed by the overlay
icon in the bottom-left corner of the viewport (yellow = recording ON, white = OFF).

Playback

The channels used by external services can be played back just in the same manner as regular channels.

For systems that have FR service(s) connected, an additional control will appear in the bottom right corner, below

the timeline. The Mysterious face  icon will allow you to switch to the FR investigation mode using the

current frame. If the target frame contains a face, you can then highlight it and form a search request as described
below. Note that you will still have to specify the channel(s) to be searched in the Resources pane on the left, as the
image may be coming from a non-FR channel.
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Investigation

For every external service type, a corresponding tab appears on the topmost panel of Luxriot EVO Monitor. Click
your desired tab to proceed with the investigation.

LPR external service tab in the Luxriot EVO Monitor application

In order to start searching for the recognition results, you need to specify the target channels first. To do this,
click the + (plus) next to the channel, service group or server name in the Resources pane on the left; you can add
multiple channels from different external service groups. Use the - (minus) next to the channel, group or server
name to deselect and exclude it from the search.

LPR channel selected in the Resources pane

Next, enter your keywords in the search field. For license plate recognition, you can enter either the whole plate
number or a part of it - with or without an asterisk (*) as a wildcard.

For face recognition, the following search adjustments are available:

upload a photo and draw a region to contain a face to search for (or switch from Playback, as described
above)
specify search accuracy (higher accuracy is recommended for better results)
enter the person's name or a part of the name if you know it is present in the FR subjects' database
use tags and attributes to refine the search

Attribute search can be performed in two modes:

OR: use commas or spaces between attributes to include results that have ANY of the listed attributes
AND: use + between attributes to display results that have ALL attributes

For example, in LPR search, entering "red Ford" will display all red cars and Fords of any colour, while searching for
"red+Ford" will only output red Ford entries.

Use the Add subject button below the result list to upload the search result to the FR/LPR server and add it to
the database. (At this point, his does not work for internal Luxriot EVO tags).
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Investigation of the face recognition results

Specify the target date and time range: the date can be either entered manually from the keyboard or selected using
the calendar control; the time can be also either entered manually or adjusted using your mouse wheel after clicking
the digits and holding your mouse cursor over the time element.

Investigation of the license plate recognition results

After that, click the Search button to view the results. Please note that, depending on the selected time range and
number of channels, the search may take some time; the results will be listed in the bottom-right-hand area after
they have been found. Do not press the Search button repeatedly: this will re-initiate the search process.

Double-click any specific search result and it will be opened in the central viewing area. The default view grid is 5x5,
you can change it by selecting an appropriate grid size below. 1x1 grid corresponds to the instant playback mode.
Click any result in the grid to see the recognition moment (plus some seconds before and after) played back on loop.
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The instant playback here has some standard Luxriot EVO Monitor controls and also an option to switch to the
regular playback mode.

Use the semi-transparent Play viewport overlay control in the centre of the picture to play faster, slower or
pause the playback: simply drag the arrow to the left/right/centre position
Timestamp in the upper-right-hand corner of the picture shows server time
The small Play icon in the bottom-right-hand corner will take you to the Playback mode
The Clock overlay control allows you to go to any particular moment in time in the same playback window
The Flag icon will open the Add new bookmark dialog box, allowing you to add a bookmark to this specific
moment
Pressing the Camera icon will export a snapshot
Pressing the Video clip icon will automatically export the piece of video, which is currently being played
The timeline contains the recognition related time interval but you can also adjust the boundaries by
clicking and dragging the arrows on the left and right sides of the timeline (minimal interval is ten
seconds)

You can switch to other tabs while investigating and you can return to the exact place where you left off by switching
back to the External Service tab, provided that you do not close the Luxriot EVO Monitor application. If you do, all
your search results will be discarded.

Found data can be saved into a CSV file (comma-separated values) that can be later parsed or opened with MS
Excel-like applications. To do this, simply click the Export CSV... button below the search result list and specify your
desired file name and path. You can also save the report into PDF or XLS format; for this, simply click the desired
option and the report will be immediately saved and reflected in the Library tab (if your application settings have the
dialog box enabled in the Library tab, you will have the dialog pop up, too).

Reports

This functionality is limited to Luxriot own Facial Recognition (FR) service only.

Similarly to counter-based reports, you can build reports using data provided by FR. The chart basis is
miscellaneous attributes (estimations) received from FR with the recognition events: age, gender, sentiment, etc.

Automatic FR report generation is also available for Luxriot EVO and can be configured in the Luxriot EVO
Console application.

Click the Reports button in the upper right corner (below the main menu, next to the Search button; the two buttons
only appear for FR service). If the button does not appear, please upgrade your FR service to the latest release. The
interface and logic here are analogous to that of regular reports.
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A report based on FR data representing hourly estimation of customer sentiment

First, select the target channel(s) in the Resources panel on the left by clicking the plus button next to them
(selected channels are highlighted). Then, specify the reporting criteria in the right-hand panel, which is divided
into several sections.

There are three chart types: bar, line and pie diagram. Regardless of the chosen type, all reports have configurable
report interval and filters. For each report, you can use multiple attributes as filters in addition to the time intervals.
Any report can be also exported as PDF or CSV.

Appearance:

Bar, line, or pie type visualization
Group by: choose the report target by selecting one of the available attributes (age, gender, tag, sentiment,
temperature)
Aggregate by: select the minimum time interval to be used for value grouping in the report - results can be
presented for months, weeks, days, hours or minutes (but reasonably, so minutes will not be available if
your report period is, say, one month)
Choose if you want the sum of the values and labels for each entity to be added to the graph

Report time interval:        

Choose the start and end date and time for the target report

Report filters:

Tags from FR
Temperature readings that were received by FR (works for certain camera integrations; please refer to our
for the exact vendor list)
Age, gender, and sentiment estimators
Week days: select days of the week that you want to be included in the report (e.g., ignore weekends)
(all days are selected by default)
Day time interval: choose the target audit interval to be analysed for each of the selected days   

Click on the items in the filter list to (de)select them: the deselected items will be struck through and grayed out.

All values are relative, i.e., represent the aggregated changes in the value for the given time interval compared to the
previous one.
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The tag Known comprises detections with any custom tag PLUS all detections of tagless subjects from the
database. This poses two important points:

1. There is no separate category for the "tagless" detections; thus, if you want reports on those people,
create tags (e.g., use the "default" tag for them).

2. The filter logic works as follows:
For the Sum values mode: if at least one tag is selected, Known is deselected.
Reports without sum: if at least one tag is deselected, Known is deselected.

When ready, hit the Make report button in the bottom of the right-hand panel to display the diagram based on your
selected criteria. The required time depends on the selected report interval and your connection type, and may take
up to several minutes.

Click the Export report... button to save the report in PDF or CSV format.
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36 Video Overlay

Channel Shortcuts

Channel shortcuts are interactive video overlay elements in live view, which allow you to switch to other (pre-
defined) channels. These can be thought of as "portals" to other channels. A simple usage scenario is to place
shortcuts on doors or street turns, so that users can track people as they move between the different camera views.

Shortcuts are configured in Luxriot EVO Console and then are visible in the Luxriot EVO Monitor application as
coloured rectangles overlaying the live video. Single clicking them will instantly display the linked resource
instead of the current channel. The shortcuts only work in live view and are invisible in other modes.

Street view camera with channel shortcuts

If the feature is not used, you can turn OFF the overlay visibility in the Luxriot EVO Monitor application settings:
this will disable the shortcut functionality. To do this, go to the Luxriot EVO Monitor main menu Edit  >Application
settings > Viewport overlays > Video overlays section and select the Always OFF option.

Text Overlay From Data Sources

If the connected server has data sources configured and these are associated with video channels, the received
textual data are displayed in Luxriot EVO Monitor application embedded with the video in the live view and in the
instant and regular archive playback, and it is also possible to search through the recorded text.

Live View

Textual data from the associated external data source will appear embedded with the live video stream. This
happens automatically and you do not have to do anything else in Luxriot EVO Monitor to enable the video overlay.
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Live video stream with text overlay

Text layout is configured via Luxriot EVO Console application for each channel.

Playback

The same functionality is available in the instant playback and regular archive playback modes, if the data stream is
set to be recorded with the target channel's video. The data stream is marked on the timeline as dark green line.
Note that the data stream is not displayed in the smart search and sequence explorer modes.

For data-only channels, advanced search is available.

Video Export

Textual data can be exported with the video clips, embedded as hard subtitles. In order to do this, you need to export
your desired video file:

as AVI with the JPEG compression
in MKV format using VP8 compression, with hard subtitles and external data enabled

making sure that you have the Include external data option enabled.
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Video export settings for clips with text overlay

Luxriot EVO Monitor User Guide

©2023 A&H Software House. All Rights Reserved.

140



37 Appearance and Operation Modes

Time Presentation

Timestamps displayed for live streams and playback (regular/instant) are using local time by default. You can
change this to UTC or to the time zone of a specific connected server: this is useful when you view contents from
many servers located in the different time zones.

You can access this setting via main menu View -> Time Presentation -> [option].

Time presentation settings do not affect event logging (Alerts tab). Also, when you export a video clip from a
remote server, which is in a different time zone, and add timestamps in subtitles, your local time will be used.

Operation Modes

Luxriot EVO Monitor has three special operation modes:

always on top
exclusive (no access to other applications or resources)
locked (all Luxriot EVO Monitor controls are unavailable)

You can activate these by selecting the relevant option via main menu View -> [option].

Each next operation mode includes the previous one. Thus, exclusivity mode also makes the application stay on top,
and the lock application mode also makes it exclusive and on top.

In order to use these modes on Windows 8, 8.1, 10 and Windows Server 2012 - the operating systems
having Windows Metro interface design - it is necessary to disable Windows Logon Screen. Without doing it,
exclusivity mode and locked application mode can be overridden by using Windows button.

In order to do so, go to your Start menu and locate the following shortcuts under Luxriot EVO category:

Disable Windows Logon Screen controls - this one will disable Windows interface elements, allowing
you to use Luxriot EVO Monitor operation modes properly
Enable Windows Logon Screen controls - this one will enable Windows welcome screen back

After disabling the Windows Logon Screen controls, launch Luxriot EVO Monitor and use application
operation modes as required.

Exclusivity and locked modes require a password to be defined, and this can be set in Application settings. If you
have not already set a new password, you will be prompted to do so upon enabling the exclusivity/locked mode.
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38 Themes

Luxriot EVO Monitor colour scheme can be modified by changing the colours of individual elements and/or element
groups: buttons, date/time pickers, overlay controls etc. This functionality is available through Luxriot EVO Monitor
main menu Edit -> Theme.

Theme settings dialog box

All elements whose colour can be changed are grouped logically within the list and shortcuts to the groups are listed
on the left hand side.

Colour palette consists of three sections:

available colours: hues used in default Luxriot EVO Monitor looks
standard colours: pure hues with names (e.g., white, gray, purple etc.)
advanced settings: fully customized colour choice from RGBA (red, green, blue and alpha for
transparency) colour picker

All colours are coded in 8-digit hexadecimal RGBA notation; colours from the standard palette can be also referred
to using names, for example, black, white, red etc.

As you change the colours, they are immediately applied to the application theme. Once you have created the
desired colour arrangement, you have the following options:

Save as: save the theme settings into a XAML file
Save: save latest theme modifications and exit
Cancel: discard the latest changes and exit
Load defaults: discard all changes and reset the colours to Luxriot provided
Export: save the theme into a file and use it on another workstation
Import: load a theme file from another workstation, or an earlier version of it

To load a XAML file formed on another workstation, use the Import button.

Alternatively: take the Brushes.xaml file generated previously and put in into the AppData directory:
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C:\Users\<user>\AppData\Local\Luxriot\Luxriot EVO

After putting the file there, restart the Luxriot EVO Monitor for the changes to take effect.

You can also put the file into the product installation directory - in that case the colour scheme will become
default. To revert to the original Luxriot EVO theme, delete the Brushes.xaml file from the installation directory
and restart the Luxriot EVO Monitor again.
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39 Administration Tool

It is possible to customise Luxriot EVO Monitor looks by restricting certain functionality if users are not supposed to
see specific tabs, panels and/or menu items. This can be achieved by using the Luxriot EVO Monitor administration
tool, which is available via Windows Start Menu, under Luxriot EVO, or via Luxriot EVO Monitor application's main
menu View -> Administration Tool.

Windows Administrator rights may be required to launch this utility (UAC in action).

Set Restrictions

After running the tool, simply unmark the features that you do not wish to appear in the Luxriot EVO Monitor
application on the current machine.

Every listed item is enabled by default; by unchecking (unmarking) them, it is possible to hide the corresponding
features from the Luxriot EVO Monitor user(s). Note that these settings are only applied to the Luxriot EVO Monitor
application instance running on the local machine and are not related to the user accounts used for server
connection, or applications running on other machines. In other words, for example, if you restrict access to the Live
tab, it will be hidden for both regular users and also the root administrative account(s).

Luxriot EVO Monitor administration tool

The tool offers the following functionality restrictions:

Visibility settings

Panes
Layouts: the whole pane containing layouts, layout templates and layout sequences on the left
hand side

Local layouts and templates in the resources pane on the left hand side, for both live
and playback modes
Shared layouts and templates: server-side resources, for both live and playback
modes
Layout sequences (local only)

Channels: channel and channel visual groups in the resources panes in the left hand side of live
view
Playback channels: channel and channel visual groups in the resources panes in the left hand
side of regular playback mode
Alarm pane: the floating panel on the right-hand side containing bookmark alarms

Tabs
Live: live view section (all secondary windows will be removed as these are only capable of live
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mode) including multidisplay setup and screen contents buttons
Playback: if disabled, regular playback tab will be hidden (users still can jump to playback via
instant playback)
Sequence Explorer : sequencing mode (advanced footage investigation)
Smart Search: search based on motion
Alerts: application notifications
Library: library tab with exported files (if disabled, users will still be able to export snapshots
and video clips)
Reports: heatmaps and reports based on VCA/software counters
Video Wall: video wall management for Luxriot EVO Global servers (users will still be able to
send resources to the video wall directly)
External Services: LPR, Face Recognition, and other external or third-party modules
operating via HTTP API
Data Sources: investigation tab for the text received from data sources
Access Control: third-party integrations of access control software

Menu buttons
File: if disabled, corresponding main menu item will be hidden, preventing user from using its
contents
Edit: if disabled, corresponding main menu item will be hidden, preventing user from changing
application settings
View: if disabled, corresponding main menu item will be hidden, preventing user from
changing application operation modes
Tools: if disabled, corresponding main menu item will be hidden, preventing user from
accessing in-app utilities
Help: if disabled, corresponding main menu item will be hidden, preventing user from using its
contents
Connections: if disabled, server connections button will be hidden (all servers that connect
automatically will be loaded, including those prompting for the password)

Live toolbar
Multidisplay setup button: if disabled, multidisplay setup will be unavailable (existing
multidisplay settings will be dropped)
Screen contents: if disabled, user will be unable to create layouts

Server Connection dialog
Remember password option: if disabled, there will be no option to save the password, and
users will be asked for the password every single time when connecting to any server in the list

Live Alarm tabs
Create new tabs: add new tabs to the alarm pane
Lock/unlock existing tabs: change the state of the existing tabs in the alarm pane    
Edit locked tabs: change settings of the tabs that have the "locked" state
Edit unlocked tabs: change settings of the tabs that have are not locked

Click Save to save the settings, then the X or the Close button to exit the application window. After saving the
settings, please restart the Luxriot EVO Monitor application for the changes to take effect.

Import and Export

Once you have fine-tuned the settings, you can save and transfer them to other workstations.

To save the settings into a *.config file: press the Export... button and specify the file name and location. You can
save the file onto a shared storage, or copy it manually onto a USB drive.

To load the settings: use the Import... option to open a file that was saved earlier or came from another machine.
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40 Archive Backup Wizard

Luxriot EVO offers an option to back up any recordings from any server manually, in the proprietary Luxriot EVO
archive format. Video, motion information, audio, VCA data streams, as well as external serial data can
be extracted from the original archive and saved elsewhere, with an option to include the portable player tool so
that the downloaded recordings can be played on any Windows-based computer, even if it has no Luxriot EVO
installed.

The wizard is included with any Luxriot EVO installation, including Luxriot EVO Console management application
and Luxriot EVO Monitor application, and allows connection to local and remote servers. 

The archive will be copied to the computer that has Archive backup wizard running on it. Thus, if you are
connecting to a server remotely via Archive backup wizard, the archive copy will be downloaded to your
computer from the server. As footage may be of significant size, make sure you have the required bandwidth
available.

Start the Archive Backup Wizard from the Windows Start menu: Start -> All Apps -> Luxriot -> Archive
Backup Wizard (in Windows 7 and older versions, use Start -> All Programs -> software installation folder -> Tools
-> Archive Backup Wizard); alternatively, use Search to locate Archive Backup Wizard in the programs menu.

From the Luxriot EVO Monitor application, the wizard can be launched via main application menu by opening View
-> Archive Backup Wizard and choosing the server (one of the connected ones). The address of the server, and also
the username and password, will be taken from the currently configured server connection.

Using Archive Backup Wizard

First, you will be asked to log into the target server: your user account must have an administrative permission to
make archive backups plus permissions to back up footage from individual channels/channel groups. You can create
archive backups from the local server or from any remote server (login procedure is analogous to Luxriot EVO
Console login), including individual recording servers. If you run the wizard from the Luxriot EVO Monitor
application, you will not be asked to log in; instead, your configured server connection will be used.

After you log in, you will be presented with the list of available recordings, grouped by channel and, if present,
by visual group. Select the channel(s) and/or visual groups you need by putting a checkmark next to each one;
specify the required time range above the channel list and click Next.
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Choose the target time interval and required channels

Depending on the number of selected channels, their footage size, storage speed and connection latency, it may take
a few moments to retrieve the stream information. Once it is done, you will be presented with a list of streams for
each of the selected channels.

The following tracks can be backed up, depending on the channel recording settings and, therefore, stream
availability:

main video stream, substream and edge recordings
video motion information
audio stream
VCA metadata
external serial data from Data sources

Archive bookmarks and external service data (e.g., LPR/FR recognition results) are not available for backup.

Additionally, you can append the portable player tool with the copied part of the archive so that you can play the
archive without having to install Luxriot EVO server on another machine. Guidelines on the portable player usage
are available in your Luxriot EVO Monitor user guide.
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Choose data streams and include portable player, if required

Here, you also need to specify a directory for the archive to be copied to: it may be a local hard disk, a shared
network storage, or an attached USB drive. You are asked to choose an empty folder as a backup destination, so
you may need to create a new folder from the standard Select folder dialog.
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Backup progress

When ready, hit Next for the wizard to proceed with backing up the selected information. Depending on the size of
the selected archive, the backup procedure may take some time and its progress will be displayed in the wizard
window. When it is finished, you will get a confirmation with a short description of what has been done.
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Archive backup succeeded

If you wish to back up more recordings, start the wizard again and follow the described procedure once again.

Postpone Your Archive Backup 

If, during the backup progress, you decide to stop it for some reason, simply hit the Cancel button in the bottom
right corner. You will then be presented with several options of how the wizard can proceed:

save the task and files: save your current backup progress and preserve the wizard state until the next time
you run it; you will be able to continue with the current backup item(s) then
save files only: leave the files that have been downloaded so far but discard the wizard settings so that the
next time you run it you will be presented with default choice
remove files: discard current backup task completely and remove the downloaded files
continue to download: go back and continue with the selected backup
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Archive backup termination options

If you have chosen to save both the task and the files, next time you start the wizard you will be reminded of the
unfinished backup job and offered to continue with it. If you click Yes to proceed with the unfinished task, it will be
started automatically right after you provide your user credentials for the server login.

Continue with an unfinished backup task
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41 Portable Player

Luxriot EVO Portable Player is a standalone application designed and optimised to play back media exported
from Luxriot EVO as well as native Luxriot EVO archive. Original archive playback also includes the opportunity
to save snapshots and export video clips into the player own library.

Portable player can be optionally appended when you copy exported files from Luxriot EVO Monitor to an external
location (burn to CD/DVD etc.), and can also be obtained from Luxriot either directly or from the website,
downloads section. This application can be transferred to any Windows machine that does not have Luxriot EVO
installed and used for viewing archive recorded by Luxriot EVO and video clips exported from such an archive.

Portable player interface

The player has three tabs:

Media Playback: for video clips that have been exported from Luxriot EVO Monitor or Portable Player
(*.avi and other file types)
Proprietary Archive Playback: for the native archive playback (original Luxriot EVO archive structure)
Library: own Portable Player library containing video clips exported from the native archive playback
mode

Below, you will find details on each mode.

The player main menu, located in the upper right corner, gives you the following options:

File
Add file/folder/archive: append a file or directory contents to the current playback list
(Channels section on the left)
Exit: close the application

Edit
Settings: overlay, language and media export preferences (see below for details)

Help
About: software version and legal information

Settings

Application settings are pretty much alike Luxriot EVO Monitor settings and include the following:

General tab: change the language and set the default setting for aspect ratio here

Luxriot EVO Monitor User Guide

©2023 A&H Software House. All Rights Reserved.

152



Viewport overlays: choose what overlay elements and controls appear on top of the video
Library: set the directory where exported files will be stored (for clips and snapshots exported from the
proprietary archive playback mode)
Snapshots export: set snapshot export defaults here
Video export: set defaults for video clip export here

Do not forget to restart the player when you change the interface language. Keep in mind that all opened
channels are discarded upon application restart.

Media Playback

This mode allows single-channel playback of video files exported earlier from Luxriot EVO archive via Luxriot
EVO Monitor or portable video player. You can usually play these files by other media players (e.g., VLC) as well.

Go to the main menu File -> and choose Add File to load a single video file, or Add Folder to open the contents of the
whole directory (e.g., Luxriot EVO Monitor library folder). The selected files will appear on the left-hand panel,
under Channels. Note that only valid Luxriot EVO files will be appended to the playlist. Use the Search field on top
of the panel to filter the displayed items.

Double-click or drag and drop any channel onto the main viewing area to start playing it. Buttons below the
timeline let you control the process.

Media file playback

Controls, from left to right:

time: current playback position/total file duration
playback: click the buttons to activate the related action

jump to beginning
jump 24hrs, 1hrs, 10min, 1min or 10sec back
go back frame by frame
regular play button
go forward frame by frame
jump 24hrs, 1hrs, 10min, 1min or 10sec forward
jump to the very end

speed: drag the blob or use the plus and minus buttons to change playback speed (from 0.5 to 128x both
ways)
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Controls that overlay the video are similar (less functionality present) as for normal Luxriot EVO Monitor playback,
including digital PTZ.
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Native Archive Playback

The Proprietary Archive Playback tab allows you to access and play back the native archive recorded by Luxriot
EVO.

The archive structure must be integral (intact) for the player to be able to read the data, i.e., if you copy a part of the
archive to a different machine, make sure to copy all index files (all those not having an MDAT suffix). We strongly
recommend that you only use the whole archive in order to maintain its integrity and guarantee normal data
playback.

If you only need a part of the archive in the native format, please use the Archive Backup Wizard: Luxriot EVO
will then ensure that all necessary files are copied correctly. This wizard can be launched from any workstation
running Luxriot EVO either from the Windows Start Menu, or from the Luxriot EVO Monitor application with the
current user account.

Portable player is only able to play the archive that is currently not used by Luxriot EVO. If a folder
containing the archive is configured to be used as archive destination on a running Luxriot EVO server, you
will get a warning dialog box and the player will not access that directory. This is to ensure that the player does
not interfere with recording.

Thus, you will be able to play either directories that are currently not used as storage (e.g, disks coming from
other servers) or local storage directories while Luxriot EVO server is stopped.

To add some archive to be displayed, click main menu File -> Add archive and locate a directory where Luxriot EVO
archive is stored (default path is DISK:\Luxriot\Archive Files). If the target archive is encrypted, you will be
prompted to enter a password.

Enter a password to decrypt the target proprietary archive

All contained tracks will be loaded and listed in the Resources panel on the left.
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Native archive playback

This mode is multichannel, meaning that you can use layout templates from the Resources section on the left
and fill them with channels for them to be played pack simultaneously.

Controls and timeline elements here are essentially the same as for regular Luxriot EVO Monitor playback, including
video export, digital PTZ and motion search but excluding some things like bookmark search and multichannel
snapshot export.

For fisheye cameras: if the target channel was set to be dewarped on the Luxriot EVO Console side, enabling DPTZ
will automatically activate dewarp in the PTZ simulation mode. You can use it in the same way as in regular
playback mode in Luxriot EVO Monitor: simply click the picture to re-centre. Overlay buttons in the bottom left
corner of the video will allow you to use presets, and also switch between region, 180-, and 360-degree panorama
modes.

Library

This section displays the contents of the folder that has been set up as destination for the files exported from
Portable Player. You can change the path via main menu Edit -> Settings -> Library tab. Both snapshots and video
files are shown, and the list is retained when the application is restarted.

Section functionality is almost the same as that of the Library section of Luxriot EVO Monitor, except for the file
export to CD/DVD and other external media.
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42 Renderer Test Utility

Luxriot EVO can utilize GPU for some operations in order to decrease the CPU load. To enable GPU acceleration,
run the Renderer Test Utility from the Luxriot EVO suite on the Luxriot EVO Monitor workstation.

There are two supported GPU operations are:

frame decoding on Luxriot EVO Monitor side
rendering on Luxriot EVO Monitor side

GPU acceleration limitations:

Only Windows 10 and corresponding Windows server OS editions (2016, 2019).
Only H.264 and H.265 streams for live view and digital PTZ in live view
For fisheye image dewarp, only Fisheye-II is supported (choose the Fisheye lens (6MP and larger
resolution) option in Luxriot EVO Console)

All other cases will use CPU for decoding/rendering operations.

Before configuring GPU acceleration, make sure you have installed the latest official drivers for all your graphics
cards. We also recommend having more memory for GPU (the more, the better). For integrated video cards, you
can change this setting in BIOS. For discrete graphics, choose ones with more onboard memory (1GB per display or
more).

For H.265: decoding is only available for the graphics cards that have HEVC support. Please check with the video
card manufacturer for the specifications.

GPU Test and Configuration

On every client workstation where you want to enable GPU usage, launch the Renderer Test Utility by locating it in
the Start menu, or simply by typing a part of the name in the Windows search. You can also run this wizard from the
Luxriot EVO Monitor application itself via main menu Tools > GPU configuration wizard. The client application
will be closed during the test and then re-opened.

The first wizard screen is a summary. Here, you can select, which graphics cards will be used for decoding and for
3D rendering. To be able to do so, first run the GPU test so that Luxriot EVO can learn about your GPU capabilities
and determine the maximum possible load. During the test, each GPU is consequently loaded with test videos of
different resolutions, starting from bigger ones. As a result, a value list is created for each GPU, which is then used
by the Luxriot EVO Monitor application for load balancing.

We recommend that you re-run the GPU test after each system change that may be related to graphics, as
well as major OS updates (like feature updates) and Luxriot EVO software upgrade.

To run the performance test: hit the Test GPU button in the bottom left corner. In the list, mark all GPUs that you
wish to engage by putting check marks in the Test column. Then, select the target codecs, and click the Test button
below.
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Select graphics cards and run the test

If you have already launched the test earlier, the Status column will reflect the last test results. For the GPUs that
have passed the test, there is no need to re-launch it, unless you have made changes to that video card configuration
(e.g., added memory for the integrated card, installed a different device driver etc.). The test may take some time. If
your Luxriot EVO Monitor application is open, the wizard will ask you to close it and re-open later (and offer to do
so automatically).

During the test, click the Show log button to see how the test is going. After the test is finished, the wizard will
automatically switch to the previous screen, and you still will be able to view the last test log.

An example of Intel graphics card that has successfully passed the test for both h.264 and h.265 decoding.

Log colours:

red: most important (errors, failures)
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yellow: warnings
blue: information
black: default
gray: trace, details or low importance

Flags used in the test log indicate GPU capabilities:

supported: graphics card is supported
unsupported: hardware decoding is not supported by OS for this GPU
legacy: video card is old or has old drivers, max resolution will be limited to 1080p
canDecode: the GPU is OK to be used for decoding
canRender: the GPU is OK to be used for rendering

As a result, the previously Not passed GPUs will change their status. GPUs that have passed the test, will be
available for decoding (putting a check mark in the Decode column). Below the table, you can choose, which GPU
will be used for rendering.

If you graphics card can decode both H.264 and H.265, you will have both codecs enabled after the test. However,
you can deselect H.265 if you do not wish it to be decoded by GPU. Do not forget to restart Luxriot EVO Monitor if
you have just opened the wizard to change the settings (without running the test).

Video output process on the Luxriot EVO Monitor side consists of two stages: decoding frames and rendering
for displaying them. After decoding, the frames are converted and passed for rendering. If decoding and
rendering operations happen on different GPUs, CPU is used in between so its load may grow a bit. Therefore,
if only one GPU is used for decoding, it may be wiser to use the same GPU for rendering. Same logic is to be
applied for cases when one GPU takes the most decoding load (this can be deduced from the GPU test log).
But, if you happen to have a GPU that does not support decoding, you may want to use it for rendering, so that
the total load is split between GPUs.

In general, according to our tests, Intel GPUs have better decoding capabilities (more channels can be
decoded by them), and Nvidia GPUs (hi-end) are good at 3D rendering.

Click OK to save the settings and exit. If you close the wizard by clicking Cancel or X, the GPU settings will not be
saved.

If you open the wizard and change any settings without running the test, please manually restart the
Luxriot EVO Monitor application for the changes to take effect.

You can re-open the wizard at any time to run the test again and/or change the settings.

Usage in Luxriot EVO Monitor

After you have enabled GPU settings via wizard, the Luxriot EVO Monitor application on the same machine will be
able to use the GPU capabilities. Using GPU acceleration will significantly decrease the CPU load and will allow you
to output more channels simultaneously on the same workstation. By combining GPU acceleration with substream
usage you can gain even more, as using lower resolution streams for multichannel output is more efficient.

Luxriot EVO Monitor will automatically use GPUs enabled via wizard, you do not have to enable anything else in the
application settings. Limitations:

live view and DPTZ
fisheye dewarp (supported dewarp mode must be set in Luxriot EVO Console, as described above)
stream codec must be H.264 or H.265
stream resolution must be supported (see GPU test log for details), e.g., legacy GPUs will not be used for
resolutions greater than FullHD

If you want to check whether the decoding is currently performed by GPU, enable rendering info in the Luxriot EVO
Monitor application settings. In the main menu, choose Edit > Settings > select the Usability tab > enable the Show
decoder information option > Save.
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Enable GPU status in Luxriot EVO Monitor

After you have enabled this setting, each viewport in the live mode will have a label next to the timestamp
(upper right corner):

CPU: decoding is performed using CPU (GPU is not configured or overloaded, or stream codec/resolution
is not compatible)
GPU: the corresponding graphics card type will appear as a label - Intel, Nvidia, AMD, or other GPU.

Luxriot EVO Monitor will automatically switch to CPU decoding if the configured GPU is overloaded (more
than 80% of its decoder, renderer or memory is used).

Make sure you have at least 512MB of dedicated video memory per display (recommended minimum is 1GB
per display).

Troubleshooting

If, immediately after enabling hardware acceleration, your Luxriot EVO Monitor application behaves strangely,
crashes, or causes other problems, try running it without GPU decoding. To do so a single time - for
troubleshooting - use the Luxriot EVO Monitor without GPU decoding shortcut from the Start menu (similar icon
but in gray colours). This shortcut activates a so-called "safe mode" for the Luxriot EVO Monitor application,
which completely ignores the GPU settings configured via GPU test utility.

After launching the Luxriot EVO Monitor application in "safe mode", check if the issue is gone. If the no-GPU mode
helps, disable GPU decoding via Renderer test utility by de-selecting GPUs in the list (remove the check mark in the
Decode column). If you have multiple graphics cards, the issue may be caused by one of them, so a wise approach
would be to enable/disable the graphics adapters one by one in order to find out, which one is causing problems.
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